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N.

Parts

N.

Parts

20 Electronic board locator pins

1

Cover

2

Base

3

Indicator lights (LED)

7

Closing screw (parked position)

8

Base mounting holes (4)

9

Cover hinge

21 JP2 current draw limiter jumper (versions with housing
only): see “Description of jumpers” on page 11
22 Battery connector: versions with housing only
23 ANTLTE-02 adapter cable
24 Adapter cable nut
25 Integrated antenna: versions with housing only

10 Antenna cable hole
11 2700 mAh rechargeable battery (optional): versions with
housing only
12 Wall tamper device
13 Hole for wall tamper device fixing
14 SIM holder
15 PC-LINK connector
16 Programming jumpers: see “Description of jumpers” on
page 11

26 Hole for antenna cable on metal bracket
27 Metal bracket
28 ANTLTE-02, multi-band antenna with 2 m cable and
SMA connector (optional)
29 Multi-band antenna with 2 m cable and MMCX
connector
30 Electronic board mounting holes (4)
31 Ethernet port: versions with housing only

17 USB port: versions with housing only
18 Tamper contact
19 Terminal boards

Figure 1 – Identification of parts: version with housing.
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Figure 2 – Identification of parts: a) version with housing; b) ANTLTE-02, multi-band antenna with 2 m cable and SMA
connector (optional); c) kit version.
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These instructions apply to communicators with firmware revision 2.00 and above.
Hereby, Tyco Safety Products Canada Ltd. declares that the radio equipment type GS4015, GS4005, GS4005-K, 3G4005/EU, 3G4005-K/EU and TL405LEEU are in compliance with Directive 2014/53/EU.
The full text of the EU declaration of conformity is available at the following internet address: GS4015, http://dsc.com/pdf/1711001; GS4005, http://dsc.com/
pdf/1603004; GS4005-K, http://dsc.com/pdf/1603005; 3G4005/EU, http://dsc.com/pdf/1603002; 3G4005-K/EU, http://dsc.com/pdf/1603003; TL450LEEU, http://dsc.com/pdf/2001003.
The GS4005, GS4005-K, 3G4005/EU and 3G4005-K/EU product models have been certified by IMQ/A to be compliant with standards:
EN 50136-1:2012 and EN 50136 2:2013 for alarm transmission system performance SP2 (D2, M2, T2, S0, I0) for vocal/text alarm messages and SP4 (D3,
M3, T4, S2, I3) for digital messages;
EN 50131-10, Security Grading 2;
T031;
EN 50130-5 Class I.
The TL405LE-EU product model has been certified by IMQ/A to be compliant with standards:
EN 50136-1:2012 and EN 50136 2:2013 for alarm transmission system performance SP2 (D2, M2, T2, S0, I0) for vocal/text alarm messages and DP3 (D3,
M3, T4, S2, I3) for digital messages;
EN 50131-10, Security Grading 2;
T031;
EN 50130-5 Class I.
To ensure conformity with the T031 standard, the Communicator must be connected to the panel with terminals LI and the following events and messages/
codes must be set: INTRUSION ALARM, TAMPER ALARM, MAIN POWER FAILURE, BATTERY FAILURE, HOLD-UP, ARMING, DISARMING,
INHIBITED ZONE AND ISOLATED ZONE.
The communicator is certified IMQ-SECURITY SYSTEMS if powered by the panel and without backup battery.
Installation of these systems must be carried out strictly in accordance with the instructions described in this manual and in compliance with the local laws
and bylaws in force. The above mentioned devices have been designed and made to the highest standards of quality and performance. The manufacturer
recommends that the installed system should be completely tested at least once a month. Digital Security Controls shall not be responsible for damage arising
from improper installation or maintenance by unauthorized personnel. Digital Security Controls reserves the right to change the technical specifications of
this product without prior notice.
RECYCLING INFORMATION
Digital Security Controls recommends that customers dispose of their used equipment (panels, detectors, sirens, and other devices) in an environmentally
sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. For specific information
see www.dsc.com.
WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT (WEEE) DIRECTIVE
In the European Union, this label indicates that this product should NOT be disposed of with household waste. It should be deposited at an
appropriate facility to enable recovery and recycling. For specific information see www.dsc.com.
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INTRODUCTION
The devices made by GS4015, GS4005, 3G4005 and TL405LE series are cellular communicators that provide a backup PSTN line
and are able to transmit vocal (GS4005, 3G4005 and TL405LE only) and SMS alarm messages to the end user, and digital messages to supported Sur-Gard System receivers. By means of the ConnectAlarm app running on Android and iOS mobile devices, you can manage the communicator, and the control panel wired to it, and view the communicator’s and control panel’s events.
The TL405LE model has an Ethernet interface that may be used as main communication channel, or for cellular communication
channel backup (dual-path), for digital message transmission to supported Sur-Gard System receivers. The Ethernet interface enables an alternative and faster way to program the communicator. The following versions are available:
GS4015: communicator board with 2G module in plastic housing.
GS4005: communicator board with 2G module in plastic housing.
GS4005-K: kit including communicator board with 2G module, antenna with 2 m cable, adapter and metal bracket.
3G4005/EU: communicator board with 3G module in plastic housing, for the Europe Union market.
3G4005-K/EU: kit including communicator board with 3G module, antenna with 2 m cable, adapter and metal bracket, for the
Europe Union market.
 TL405LE-EU: dual-path communicator board with LTE module and Ethernet interface, in plastic housing, for the Europe
Union market.
 TL405LE-LAT: dual-path communicator board with LTE module and Ethernet interface, in plastic housing, for the Latam
market.
 TL405LE-ANZ: dual-path communicator board with LTE module and Ethernet interface, in plastic housing, for the Australian
and New Zealand markets.







For special installation requirements, a remote outdoors antenna ANTLTE-10 with 10 m cable is available.
The information in this manual is common to all versions. The term “communicator” refers to functions shared by all versions. Information relating to specific models is highlighted with reference to the respective code.

 Some of the topics found in this manual may not be relevant to your version: refer to “General specifications” on page 6 to see
the features of your version. References to Ethernet apply to TL405LE only.
This manual provides instructions for programming and using the communicator.

Safety instructions
Read the safety information before you install the equipment.

!

Important: This equipment must be installed by a skilled person only. A skilled person is an installer with appropriate
technical training. The installer must be aware of potential hazards during installation and measures available to
minimize risks to the installer and other people.

 Before you install this equipment, disconnect all power sources (for example mains, battery, and telephone line) connected to
the alarm panel.
 Install the equipment indoors in a non-hazardous environment where the following conditions are met:
– Pollution degree - Maximum 2
– Over voltages - Category II
 Internal wiring must be routed to prevent strain on wire and terminal connections, loose terminal connections, and damage to
conductor insulation.
 Instruct the user that there are no user serviceable parts in this equipment. All equipment must be serviced by a skilled
person

 These instructions must be used in areas together with the panel's installation manual. Follow all instructions given in this
manual.

GS4015/GS4005/3G4005/TL405LE
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GS4005-K

3G4005/EU

3G4005-K/EU

TL405LE-EU

TL405LE-LAT

TL405LE-ANZ

Boxed
Mobile phone standarda
Dual Band
Quad Band
Dual path
Simulates a PSTN line.
Detects the absence of a PSTN line and automatically switches to cellular network
Manages and reports incoming and outgoing phone calls
Cellular signal strength indicator
Terminals, programmable as open-collector outputs or inputs
T1, T2 and T3 terminals
Remote management of inputs and outputs through the ConnectAlarm app
Protection against overvoltage on the phone line
Integrated antenna
External antenna with magnetic base
SMS message transmission to mobile phone and ConnectAlarm app for
communicator’s events
Voice message transmission over cellular network for communicator’s events
Conversion of Contact ID and SIA messages of control panel connected to LI
terminals, to SMS, and push notifications to ConnectAlarm app
Conversion of Contact ID and SIA messages of control panel connected to LI
terminals, to voice messages over cellular network
Contact ID and SIA message transmission to PSTN and IP Sur-Gard System I, II, III,
IV and 5 receivers
Options programmable by PC
Communicator blocked when PINs are at default (EN50136-2)
Programmable text messages (each at most 70 characters long)
Text messages for each input
Status text messages
Periodic text message
Programmable telephone numbers (16 digit max.)
Phone numbers for sending SMS messages
Phone numbers for transmitting events to Sur-Gard receivers
Phone numbers for remote output activation
Remote output activation via call recognition, or SMS
Residual credit monitoring for prepaid SIM cards
Panel Transmission Monitoring (PTM)
Tamper detection
PC-LINK port
Type A USB connector (Host and device)
Ethernet interface
Programming with USB key
Advanced diagnostics and event log exporting by means USB key
Loading custom default via USB key
Firmware programming and updates, both local and remote
Alarm event transmission via cellular network
Alarm event transmission via Ethernet channel

GS4005

Model

GS4015

General specifications
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a.
b.
c.

3G4005-K/EU

TL405LE-EU

TL405LE-LAT

TL405LE-ANZ
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GS4005-K
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3G4005/EU

GS4005

Priority programmable with PSTN/Cellular
Two-way communications with cellphone
Optional backup battery
Current limitator (JP2 jumper)
Alarm panel management and status monitoring
Remote programming of PowerSeries panels via cellular network (Pass-Through)b
Remote programming of PowerSeries panels via Ethernet (Pass-Through)c
Jamming detection
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Check that the SIM operator in use supports 2G, 3G, or LTE standard, depending on the model, in the area where
the communicator is installed.
See “Pass-Through” on page 86 for more information.
See “Pass-Through” on page 86 for more information.

GS4015/GS4005/3G4005/TL405LE
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Technical specifications
The power for the communicator is supplied by the panel to which it is connected (10.7 V to 27.6 V) or by an external power supply
which also recharges an optional backup battery, if necessary. The sole purpose of the battery is to supply power in case of failure
of the primary power source (8 hours stand-by).

 When the communicator is powered by the battery, ONLY communicator events are transmitted.
The primary power and (optional) battery voltages are supervised.
The power supply for communicators with housing must be SELV, with power limited to 1 A.
GS4015
GS4005
3G4005/EU

GS4005-K
3G4005-K/EU

Version
Input Voltage

TL405LE-EU
TL405LE-LAT
TL405LE-ANZ

from 10.7 to 27.6 V_ from 10.7 to 27.6 V_ from 10.7 to 27.6 V_

Standby average current @ 13.8 V_, without
battery (not including outputs)

90 mA

90 mA

110 mA

Average current consumption per hour

100 mA

100 mA

120 mA

Maximum current draw in current limited mode @
13.8 V_ (versions with housing only, not including
outputs)

230 mA

230 mA

230 mA

Maximum current draw @ 13.8 V_ (not including
outputs)

450 mA

450 mA

470 mA

Maximum current on open-collector output

100 mA

100 mA

100 mA

Maximum loop resistance of line between the device
connected in series on LI

1 Kohm

1 Kohm

1 Kohm

Maximum number of parallel devices connected on
LI

1

1

1

Environmental class
Operating temperature

II

II

II

from -10 to +40°C

from -10 to +40°C

from -10 to +40°C

Humidity

from 0 to 95%

from 0 to 95%

from 0 to 95%

Dimensions (LxHxD)

76x151x20 mm
(PCB only)

101x186x41 mm

101x186x41 mm

66 g

250 g

250 g

Weight
Table 1 – Technical specifications.

Version
GS4015, GS4005, GS4005-K

Operating frequency (MHz)
GSM/GPRS/EDGE

UMTS/HSPA

LTE
N/A

850/900/1800/1900

N/A

3G4005/EU, 3G4005-K/EU

900/1800

900/2100

N/A

TL405LE-EU

900/1800

900/1800/2100

700/800/900/1800/2100/2600

TL405LE-LAT

850/900/1800/1900

850/1700/1900/2100

700/850/1700/1800/1900/2100/2600

TL405LE-ANZ

N/A

800/850/900/2100

700/800/850/900/1800/2100

Table 2 – Operating frequency.

8

Universal Cellular/Ethernet Communicators

firealarmresources.com

Maximum radio-frequency power

Class 4 (2 W) @ 850/900 MHz, GSM
Class 1 (1 W) @ 1800/1900 MHz, GSM
Class E2 (0.5 W) @ 850/900 MHz, EDGE
Class E2 (0.4 W) @ 1800/1900 MHz, EDGE
Class 3 (0.25 W) @ 850/900/1900/2100 MHz, WCDMA
Class 3 (0.2 W) @700/800/850/900/1800/1700/1900/2100/2600 MHz, LTE

Table 3 – Maximum radio-frequency power.

Interface type between SPT (Supervised
Premises Transceiver) and AS (Alarm System)

Proprietary interface

ATS (Alarm Transmission System)

SINGLE PATH

Alarm Transmission System performance

SP4 for digital
messages

DUAL PATH

SP2 for vocal/
text messages

DP3 for digital
messages

SP2 for vocal/
text messages

Average transmission time

D3 (20 s)

D2 (60 s)

D3 (20 s)

D2 (60 s)

Maximum transmission time

M3 (60 s)

M2 (120 s)

M3 (60 s)

M2 (120 s)

Reporting time

T4 (180 s)

T2 (25 h)

T4 (180 s)

T2 (25 h)

Substitution security

S2

S0

S2

S0

Information security

I3

I0

I3

I0

Table 4 – EN 50136-1:2012 and EN 50136-2:2013 specifications.

GS4015/GS4005/3G4005/TL405LE
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Identification of parts
Numbers given in bold in this manual refer to the main parts of the communicator shown in figure 1 and 2, and the table on page 2.
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Description of jumpers
Jumper

Position

PST

Description
Pass-Through disabled (factory setting).
Pass-Through enabled (see “Pass-Through” on page 86).

USB

The communicator behaves as a USB Device (factory setting).
The communicator behaves as a USB Host.

TMP

Anti-tamper function enabled (factory setting).
Anti-tamper function disabled.

UFC

Future use.

JP2
(versions with
housing only)

No limit to communicator current draw (factory setting).

Communicator current draw limited to 230 mA.

!

Backup battery required!

Table 5 – Description of jumpers.
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Description of indicator lights
The communicator is equipped with indicator lights (LED) which report the following information.

 During initialisation, all LEDs light up for less than 1 second. During factory settings restore, LEDs
LEDs
LED

and

and

are off while

are on.

Colour

Name

Description

Green/yellow

Cellular signal strength

Type of network for packet service (see table 7).
Cellular signal strength (see table 8).
Type of communication (see table 9).

Red

Fault

See table 10.

Yellow

Line status

On: the communicator has switched to the simulated PSTN.
Slow flashing: line occupied, voice message transmission.

G

Green

Cellular network status

Technical assistance LED.

ACT

Green

USB

On: Host.
Off: Device.
Slow flashing: error.
Fast flashing: activity.

Table 6 – Indicator LED.

LED

Colour

Type of network for packet service

Green

2G

Yellow

3G

Green and Yellowa

LTE

Table 7 – Type of network for packet service.
a.

Green and yellow colours may not be visible on the communicator’s cover, for the communicators with housing: you
may see just the yellow colour.

Cellular signal strength
Off

Off

No cellular signal.

Off

On

Low cellular signal strength.

On

On

High cellular signal strength.

Table 8 – Cellular signal strength.
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Type of communication
Slow flashing

Slow flashing

Initialisation: the LEDs flash until the communicator receives a cellular signal.

Fast flashing

Off

SMS incoming: the LED flashes for a few seconds.

Slow flashing

Off

Remote session: the LED may flash for a few seconds after the end of the session.

Off

Slow flashing

Voice call: reports the communicator's voice call, NOT the voice calls of the panel
connected to the communicator, if any.

Table 9 – Type of communication.

Fault LED
This LED is usually off. It flashes to indicate a fault. The communicator monitors faults in the order given in table 10. The most
important fault status is indicated, with the respective number of flashes of the RED LED, as shown in the following table.
Priorities

Description

Flashes

1 (HIGH) Firmware problem (incorrect firmware): invalid data in external flash memory.

1

2

Power problems: the power voltage falls below 10 V.

2

3

Battery problems: the battery voltage falls below 3.4 V.

3

4

Factory PIN: the EN50136 option is enabled and the User, Installer or Level 4 PIN is that set in the
factory.

4

5

Radio module fault: the microprocessor is unable to communicate with the radio module during the
initialisation sequence.

5

6

SIM problem: SIM card PIN check enabled.

6

7

Cellular network problem: the radio module is unable to connect to the cellular network.

7

8

Mobile data network problem: the radio module is unable to connect to the mobile data network.

8

9

Future use.

9

10

IP 1 receiver problem: initialisation failure; supervision failure; no ACK.

10

11 (LOW) IP 2 receiver problem: initialisation failure; supervision failure; no ACK.

11

Table 10 – Fault LED.
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Description of terminals
Terminals T1, T2, T3, T4, T5 and T6 can be programmed as described below.
 Open-collector outputs: the outputs can be activated by programmed events (automatic activation), SMS or by call
recognition (remote activation); see “Activating outputs” on page 35 for details. The maximum current draw per output is
100 mA.
 Inputs: the inputs send SMS or voice messages when activated.
Terminals
-

GS4005/3G4005/TL405LE

GS4015

Earth: this terminal must be connected to the electrical system earth to protect the device against overvoltage on
the telephone line and to satisfy safety requirements.

LI

Internal telephone line: these terminals must be connected to the panel or other communications terminal.

LE

External telephone line: these terminals may be connected to the PSTN line.

T1

Factory setting: output, PSTN fault.

N/A

T2

Factory setting: output, no cellular network.

N/A

T3

Factory setting: input, interconnection present.

N/A

T4

Factory setting: output, tamper.

Factory setting: output, PSTN fault.

T5

Factory setting: output, cellular fault.

Factory setting: output, no cellular network.

T6

Factory setting: output, Jamming.

Factory setting: output, tamper.

M

Ground: power negative and common terminals for the open-collector outputs.

+V

Power supplied by panel 10.7 to 27.6 V_: make sure it is protected and current limited (Limited Power Source —
LPS) in conformity with EN 60950-1:2006 standard).
To connect the power, use cable of no more than 3 meters length, and 0.75 mm² cross-section.
For shorter cables, use appropriate cross-sections.
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Installation
!

Connect the power supply and telephone circuits after the communicator is mounted and connected to the building
ground circuit.
Before fitting or removing the SIM card, make sure the communicator is NOT powered up.

 The communicator shall be installed only by a QUALIFIED TECHNICIAN, indoors, in a safe, dry position, away from RF
transmitting equipment.
Position the communicator for good cellular signal coverage.
DO NOT route any cable over the circuit board.
Do not use power cables which are more than 3 m long.

GS4015/GS4005/3G4005/TL405LE
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Installing the kit version
The kit version is composed of a circuit board for mounting inside a burglar alarm panel, preferably in a metal housing, and an antenna for connecting to the board with a coaxial cable.
During normal operation, the board, antenna, and cable may generate electromagnetic fields and may disturb nearby electronic
equipment which is not immune to such fields. Position the board as far away as possible from electronic equipment, and mount
the antenna on the housing's outer surface or far away from it, using the appropriate bracket.
Route a minimum amount of coaxial cable into the metal housing; gather any excess outside the housing.
To install the kit version, proceed as described below and in figure 3.
1.
2.
3.
4.
5.

Open the panel.
Find a place inside the panel to mount the board, including its wiring.
Mount the four provided adhesive plastic mounts into holes 30 of the communicator, as shown in figure 3.
Secure the communicator inside the panel.
Optional: If the panel has a plastic housing, or if you want to place the antenna within 2 metres of the panel for better cellular
signal strength, mount bracket 27 in the desired position and route the antenna cable through hole 26.
6. Position antenna 29 on the panel's metal housing or on bracket 27, so that the magnetic base adheres to the surface.
7. Route the antenna cable through an opening in the housing.
8. Connect the antenna cable to communicator connector 43.
9. Fit the TMP jumper to disable tamper detection.
10. Continue with the installation as described in paragraph “Power and testing” on page 20.
11. Close the panel.
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29
27
26
29

A

30

B

43

C

30

30
B
D
30

30

E

Figure 3 – Installing the kit communicator: A) metal housing; B) communicator board; C) panel motherboard; D) adhesive plastic
mount; E) base of metal housing.
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Installing the version with housing
The version with housing must be mounted to a wall with screws and plugs (not included) as described below and shown in figure 4.
1.
2.

!
3.
4.

Open the communicator: insert a flathead screwdriver into holes 33 and prise the cover off the base, then slide the cover
upwards to separate it from the base completely.
If you wish to fit the optional battery LIB2A6, read the following steps, otherwise go to step 7.
Risk of explosion if battery is replaced by an incorrect type. Dispose of used battery according to the manufacturer's
instructions. Batteries are to be replaced by service persons only.
Remove the electronic board: compress hooks 34 to release the board from the base.
Fit the battery as shown in figure 4.

 Make sure the silicon/graphite grommet 12 is in place.
5.
6.

Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.
Connect the battery to connector 22 after having powered the communicator up with terminals +V and M.

 The communicator will NOT operate correctly if it is powered only by the battery when first switched on.
7.
8.

!
9.
10.
11.
12.
13.

18

Mark the positions for the 8 base mounting holes and the position of hole 13 for the wall-tamper device.
Drill holes in the marked positions.
Take care not to damage any wires or tubes running inside the wall.
Route the ducted cables in the wall through openings 35 or break out the tabs 32 to route the exposed cables into the
housing.
Mount the base to the wall.
Continue with the installation as described in paragraph “Power and testing” on page 20.
For dual-path version only, break the knock-out 35 if you connected a Ethernet cable: break section 35a, and 35b, according
to the Ethernet cable type you are using, as shown in figure 4a and 4b.
Close the communicator: remove screw 7 from its parked position; slightly tilt the cover; approach the top of the cover to the
base; slide the cover downwards; press the bottom of the cover against the base until it snaps into place; if necessary, secure
the cover to the base with screw 7 in hole 36.
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8
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31
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34
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Figure 4 – Installing the communicator with housing.
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Power and testing
1.

Fit the SIM card into SIM holder 14 as shown by the arrows, with its contacts facing downwards.

 The operation related to the communicator's Ethernet channel works properly without inserting SIM card also.
For the communicator to work properly, you must use a 32 kB or better SIM card.
You must disable the SIM card's PIN before fitting it into the communicator.
Disable call transfer on the SIM card.
2.
3.
4.

Set the jumpers as required by your application (see “Description of jumpers” on page 11).
Make the connections to terminal block 19 as described in paragraph “Connection example” on page 23.
For the dual-path version only, connect the Ethernet cable to the connector 31, if required.

5.

Power up the communicator: all LEDs will light up for 1 second, then LEDs

6.

7.

and

will stay on for a few seconds,

after which LED
will flash 4 times to indicate that the User, Installer and Level 4 Installer PINs are the factory default
settings.
Use the Console to change the PINs, as described in chapter “PC PROGRAMMING” on page 42, and enable the
communicator.
Check the signal strength: make sure that at least LED

turns on; if the LED

is on, the signal strength is excellent.

If LEDs
and
are off, the signal is NOT strong enough: reposition the communicator or try installing the optional antenna
ANTLTE-02 (versions with housing only) or ANTLTE-10, as described in the respective paragraphs.

 The communicator complies with the EN 50136-2 standard and, for this reason, its access codes have to be set at the first
power up, by means of the Console, in this way the communicator functionality will be enabled.
If you do not need the compliance with the EN 50136-2 and like to start working without the Console, please proceed as follows.
1.
2.
3.

Make sure that the communicator settings are at default (read “Restore Factory Settings” on page 45 to restore the default
settings).
Insert the PST jumper.
Connect the communicator to the power.

4.

Wait until the

and

LEDs switch off, then remove the PST jumper.

 Leave the PST jumper inserted if you want to use the pass-through functionality.
Installing the antenna ANTLTE-02
The ANTLTE-02 has greater gain than the communicator's integrated antenna in the version with housing, and can be mounted
indoors within 2 meters of the communicator, to improve cellular reception, as described below and shown in figure 5.

 Position the antenna to optimise cellular reception.
1.
2.
3.
4.
5.

20

Break the tab closing hole 37.
Remove the electronic board: compress hooks 34 to release the board from the base.
Remove nut 24 and washer 38 from adapter cable 23.
Fit adapter cable connector 39 into hole 37, the secure it with nut 24: washer 38 is not required.
Connect adapter cable connector 40 to connector 43.
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6.

Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.

 Make sure the adapter cable is routed as shown in figure 5.
7.
8.
9.
10.

Secure metal bracket 28 as desired with holes 41.
Route antenna connector 42 through hole 26 in the bracket.
Position antenna 29 on the bracket so that its magnetic base adheres to its surface.
Connect antenna connector 42 to adapter cable connector 39.

37

24
38
39
23

28

34
31
40
41
41

34
31

26
27

42
39
24
43
40

Figure 5 – Installing the antenna ANTLTE-02.

Installing the antenna ANTLTE-10
The ANTLTE-10 has greater gain than the communicator's integrated antenna in the version with housing, and can be mounted
outdoors within 10 m of the communicator, to improve the mobile reception.
Refer to the installation instructions included with the ANTLTE-10 antenna.

Tamper detection
The version with housing of the communicator is equipped with a device which detects when the cover is opened and the communicator
is removed from the wall (tampering).
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Tampering is reported by the Tamper event, to which actions can be associated (activate outputs, send voice, SMS or digital message)
with the Console: the factory setting is that terminal T4 on GS4005/3G4005/TL405LE or terminal T6 on GS4015 is floating (it is normally connected to earth) in the event of tamper.
Once you have programmed the function, close the cover and power up the communicator.
After initialisation, open the cover and check that the communicator actually executes the actions programmed for the tamper detection.

22
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Connection example
!

Incorrect connections may result in FTC fault or improper operation. Inspect wiring and ensure connections are
correct before applying power. DO NOT route any wiring over circuit boards; maintain at least 1” (24.5 mm)
separation. A minimum 1/4” (6.4 mm) separation must be maintained at all points between Power Limited wiring and
all other Not-Power Limited wiring.

 To ensure conformity with EN 50136-2, the communicator must be connected and programmed as described in paragraph
“Conformity with EN 50136-2:2013” on page 80.

Figure 6 – Connection example: A) Communicator; B) disconnect the telephone line before servicing the unit; C) example
connection of terminal T1 programmed as open-collector output; D) power 10.7 - 27.6 V_; E) terminals T1, T2, T3,
T4, T5 and T6 can be programmed as open-collector outputs or input lines; F) burglar alarm panel; G) connection to
telephone line (PSTN); H) ground connection (obligatory).
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GENERAL DESCRIPTION
This communicator can communicate with central stations, and send both SMS and voice messages, via the cellular network; it
can also simulate a PSTN line in case of malfunction (phone line failure) or substitute of one completely in areas with cellular coverage in which PSTN calls are not available.

 SIA and CID messages may NOT be understood by the PSTN receivers due to distortion on the cellular network. It is
recommended to forward SIA and CID messages to IP receivers instead, when the PSTN line fails, as indicated in
“Phonebook” on page 46: see the option IP Receiver on GSM Path.

 Due to the nature of the cellular network, the communicator may be used solely for its intended purpose and NOT as a modem
for sending faxes or data or for remote assistance services.
It can report alarms over the cellular network, for reliable, fast communications with central stations equipped with compatible SurGard System receiver. The performance of the communicator depends largely on the coverage, and it should not be installed without having first checked the position of the antenna for best reception (the LED

at least must be on).

The dual path versions have an Ethernet interface that can be used as primary or backup communication channel with the SurGard receivers. The Ethernet interface also enable an alternate and faster way of communication with panels and the console software.
The communicator has terminals (T) which can be programmed as inputs or outputs (see “Inputs/Outputs” on page 55).
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Access levels
This paragraph describes how to access the communicators functions, according to EN50136 standard.
If the EN50136 option is enabled (factory default; see “Options” on page 49), the communicator can handle all four levels of user
access to its functions. The access levels are as follows.
 Level 1: access to function display, indications (LEDs used to report faults, cellular status, and PSTN status) and messages
(SMS, voice, etc.) available to all users without PIN; this level does not allow any programming.
 Level 2 (normal user): access to communicator status information (e.g. use of the Console to display the status page,
programming options and events buffer). This level requires a PIN. Factory setting: 000000.
 Level 3 (installer): access to configuration functions including addition, removal and replacement of components and other
operations which directly or indirectly affect the communicator's functions (e.g. upload/download programming options with
the console, display Status page and events buffer). This level requires a PIN. Factory setting: 111111.

 If the EN50136 option is enabled, the installer must be authorised by the normal user.
 Level 4 (level 4 installer): access to firmware updates and Status page display. This level requires a PIN.
Factory setting: 222222.

 The level 4 installer must be authorised by the installer.
To ensure compliance with EN 50136-2: 2013, the PINs for access to levels 2, 3 and 4 are 6 digit numbers.
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USB connector functions
The communicator has a USB A connector to enable it to work as a device, to connect it to a PC, or as host, to handle a USB key
(see “Description of jumpers” on page 11).
To connect the communicator to a PC, you need a USB cable with A connectors at each end (hub cable).
The USB interface has the following characteristics.







Conformity: USB 2.0.
Full speed data: 12 Mbit/s.
Max. length of cable: 5 m.
Max. current in host mode: 500 mA.
Vout in Host mode: 5 V nominal.
USB key file system: FAT32.

USB device
The USB interface will be an alternative to communications with the RS232 port (PC-Link). It will have the same functions as the
RS232 and will be used with the Console to:





update the firmware (level 4 installer only);
upload/download communicator options and audio files (installer only; the normal user can only upload);
upload the communicator's events buffer (installer and normal user only);
check the communicator's status in real time (all users).

USB Host
Allows you to use a USB key for the following operations:






firmware updates;
load custom default;
upload/download settings and audio files;
export the events buffer;
export the communicator's debug buffer (technical service only).

These functions are available only if the EN50136 option is disabled.
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Power Monitor
The device can be powered in the following ways:
1.
2.

by the burglar alarm panel, equipped with a backup battery, in which case the communicator must operate at voltages in the
range 10.7 to 27.6 V.
by an external 12 V power supply, in which case the power supply must recharge the communicator's optional backup battery
(8 hours of operation following primary power outage).

In both cases, the battery ensures that the communicator is still operational in case of power failure.
The power and battery voltages are supervised so that the communicator can report the following events:
 Power fault/restore event.
 Power fault/restore message (voice / SMS / message to the IP receivers).
Since the device can operate with or without an external backup battery (without input current limitation), the following two scenarios
correspond to a power failure.

Power voltage check
The power voltage will be supervised to detect problems. The voltage is checked every 100 ms. The following conditions apply to
the device without external backup battery:





Power problem event: when the voltage drops below 10 V (the PSTN interface is turned off).
Power problem restore: when the voltage rises above 12 V.
Start Energy Save mode: when the voltage drops below 9 V (the USB interface and the radio module are turned off).
Quit Energy Save mode: when the voltage rises above 10.7 V.

 When the communicator is in Energy Save mode, the current draw does not exceed 175 mA. The maximum current
consumption, in Energy Save mode with battery connected and no action in progress is around 70 mA and is less than 150 mA
during voice calls.

Battery voltage check
The battery voltage will be supervised to check for any faults and that the battery itself is present. The voltage is checked every
100 ms. The value is processed (mean of values) to eliminate peaks. The following conditions apply to the device with external
backup battery:









Battery problem event: when the battery voltage drops below 3.4 V.
Battery problem restore: when the battery voltage rises above 3.7 V.
Start Energy Save mode: when the battery voltage drops below 3.2 V.
Quit Energy Save mode: when the battery voltage rises above 3.4 V.
Battery disconnected event: when the battery voltage drops below 2.0 V.
Battery disconnected restore: when the battery voltage rises above 2.0 V.
Battery overload event: when the battery voltage rises above 4.4 V.
Battery overcharge restore: when the battery voltage drops below 4.3 V.

 When the communicator is powered ONLY by the battery, you can NOT use the USB port.
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Internal events
Along with the external events (panel events decoded with the Contact ID or SIA protocol on the simulated PSTN line), the communicator can send voice messages, SMS messages, and Contact ID or SIA messages for the events listed in the Table 11, as
indicated in “Communicator” on page 62.
Event

Description

Input 1 Event

This occurs when terminal T1 is programmed as an input and the conditions for its
activation occur (see “Inputs/Outputs” on page 55).

Input 2 Event

Like Input 1 Event but for terminal T2.

Input 3 Event

Like Input 1 Event but for terminal T3.

Input 4 Event

Like Input 1 Event but for terminal T4.

Input 5 Event

Like Input 1 Event but for terminal T5.

Input 6 Event

Like Input 1 Event but for terminal T6.

Input 1 Restore

This occurs when terminal T1 is programmed as an input, and returns to standby status
(see “Inputs/Outputs” on page 55).

Input 2 Restore

Like Input 1 Restore but for terminal T2.

Input 3 Restore

Like Input 1 Restore but for terminal T3.sono

Input 4 Restore

Like Input 1 Restore but for terminal T4.

Input 5 Restore

Like Input 1 Restore but for terminal T5.

Input 6 Restore

Like Input 1 Restore but for terminal T6.

Mains Fault

Happens when the power voltage (terminal +V) drops below 10 V.

Mains Fault Restore

Happens when the power voltage (terminal +V) rises above 12 V.

Battery Fault

Happens when the battery voltage falls below 3.4 V.

Battery Restore

Happens when the battery voltage rises above 3.7 V.

Panel Interconnection Fault

Happens when the terminal programmed as the Panel Interconnection Present input
is activated (see “Inputs/Outputs” on page 55).

Panel Interconnection Restore

Happens when the terminal programmed as the Panel Interconnection Present input
is deactivated (see “Inputs/Outputs” on page 55).

Cellular Receiver 1 Fault

Happens when the communicator is NOT able to communicate with receiver 1, over the
cellular channel: initialisation failure, supervision failure or receiver does not respond (see
“IP Receivers” on page 68).

Cellular Receiver 2 Fault

Like Cellular Receiver 1 Fault but for receiver 2.

Cellular Receiver 1 Restore

Happens when the communicator is able to communicate with receiver 1, over the cellular
channel: initialisation successful, supervision successful or receiver responds (see “IP
Receivers” on page 68).

Cellular Receiver 2 Restore
Ethernet Receiver 1 Fault

Like Cellular Receiver 1 Restore but for receiver 2.
Happens when the communicator is NOT able to communicate with receiver 1, over the
Ethernet channel: initialisation failure, supervision failure or receiver does not respond
(see “IP Receivers” on page 68).

Ethernet Receiver 2 Fault

Like Ethernet Receiver 1 Fault but for receiver 2.

Ethernet Receiver 1 Restore

Happens when the communicator is able to communicate with receiver 1, over the
Ethernet channel: initialisation successful, supervision successful or receiver responds
(see “IP Receivers” on page 68).

Ethernet Receiver 2 Restore

Like Ethernet Receiver 1 Restore but for receiver 2.

Table 11 – Description of events handled by communicator.
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Event

Description

PSTN Fault

Happens when the voltage on terminals LE is less than 2.5 V for the set LE Failure
Timeout (sec) (see “Timeouts” on page 71).

PSTN Fault Restore

Happens when the voltage on terminals LE is more than 2.5 V for the set LE Restore
Timeout (sec) (see “Timeouts” on page 71).

GSM Fault

Happens when the cellular signal is missing.

Cellular Network Fault

The communicator can NOT connect to the cellular data network.

Cellular Network Restore

The communicator can connect to the cellular data network.

Tamper Event

Happens when tamper detection is enabled (see “Description of jumpers” on page 11)
and the communicator is opened or removed from the wall (versions with housing only).

Tamper Restore

Happens when tamper detection is enabled (see “Description of jumpers” on page 11)
and the communicator is closed again or mounted to the wall (versions with housing
only).

FTC Fault

Happens when an action fails (voice call, SMS, digital message).

FTC Restore

Happens when the last action in the queue terminates successfully.

Periodic Call/SMS

Happens when programmed (see “Communicator Options” on page 62).

Periodic Test Transmission

Happens when programmed (see “Communicator Options” on page 62).

Antenna Fault

Happens when the antenna is missing or the antenna has limited function (ANTLTE-02
only).

RF Jam Detected

Happens when the communicator detects a jamming attack.

Ethernet DoS Detected Fault

Happens when the communicator detects a DoSa attack on the Ethernet channel.
Ethernet DoS Detected Restore Happens when the communicator does NOT detect any DoS attack.
Ethernet Network Fault

Happens when the communicator does NOT see the LAN network.

Ethernet Network Restore

Happens when the communicator sees the LAN network.

Table 11 – Description of events handled by communicator.
a.

A denial-of-service attack (DoS attack) is a cyber-attack where the perpetrator seeks to make a machine or network
resource unavailable to its intended users by temporarily or indefinitely disrupting services of a host connected to
the Internet.

The installer can choose which protocol to use: Contact ID or SIA.

 The selected protocol is also applied to events generated by the panel and sent to the phone numbers with the IP Receiver
on GSM Path option enabled (see table on page 46).
To each event associated with the communicator's inputs, a specific Customer code can be assigned, while status events can
be assigned a unique user code.
The communicator handles a queue of 32 internal events. When the queue is full, further events are ignored.
The priority between internal and external events can be programmed by the installer (see “Priorities” on page 50).
For internal events, the times and manners in which they are sent are handled by the communicators: after a message is sent, the
unit waits for at most 1.25 seconds for the receiver to acknowledge reception (ACK). The unit will try to send a message up to
4 times.
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Operating Principles
The communicator can choose its primary channel (the factory setting is PSTN). It supplies the line and ringtone voltage for incoming calls and decodes dial tones (DTMF). The simulated PSTN line provides a backup for the burglar alarm panel or other terminal
should the main PSTN line fail. Calls CANNOT be switched between PSTN and cellular, or vice-versa, while they are in progress.
Operating priority (as programmed) determines how the communicator handles SMS and voice messages, and calls with devices
connected to terminals LI (for example, a burglar alarm panel).

 The communicator is NOT able to decode pulse dialing.
To prevent undesired use of the simulated line via cellular, the device generates a double beep during voice calls. It does so
after 5 minutes and every 30 seconds thereafter.

PSTN channel
If the voltage on the PSTN terminals (LE) falls below 2.5 Vdc (± 20%) for 10 to 3600 seconds (programmable value), the devices
connected to terminals LI are switched to the cellular network. When PSTN service is restored, the communicator switches back
to the PSTN line, again after a programmable delay.

 It is possible to force communications to the cellular data network, even when PSTN is present, by entering a programmable
prefix (factory setting “9999”) ahead of the phone number dialled by the panel (for further details, see Dialing Prefix in
“PSTN/PTM” on page 71).
If the device is on the simulated PSTN line for any reason, the prefix is deleted from the number (if present).
Number dialled by
panel

Phone line

Number with IP Receiver
on GSM Path enabled

Effect

0123456789

PSTN

None

PSTN voice call to 0123456789.

99990123456789

PSTN

0123456789

Contact ID call on cellular data network.

99990123456789

PSTN

None

Voice or Contact ID call on cellular channel to
0123456789.

99990123456789

Simulated PSTN

0123456789

Contact ID call on cellular data network.

99990123456789

Simulated PSTN

None

Voice or Contact ID call on cellular channel to
0123456789.

 The communicator makes independent calls only on the cellular channel, and not on the PSTN line. All communications made
on the external PSTN line (terminals LE) come from the line connected to terminals LI, and are not modified. It follows that
the PSTN line connected to LE is not considered a communications channel pursuant to EN 50136.

Cellular channel
This provides the devices connected to the LI terminals with a simulated PSTN line if cellular reception is detected. If there is no
cellular coverage, it switches to PSTN.

Ethernet channel
If the communicator’s Ethernet interface is connected to a LAN or WAN you can:
 decode the digital messages, coming from the control panel connected to the communicator, and forward them to an IP
receiver, over Internet;
 send the communicator’s digital messages to an IP receiver, over Internet;
 downloading and uploading the communicator’s options locally via LAN and remotely via WAN.
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Contact ID and SIA transmission sequence on cellular and Ethernet channel
If the PSTN is missing, or the PTM (Panel Transmission Monitoring) is enabled (see “PSTN/PTM” on page 71), the communicator
may forward the Contact ID and SIA messages of the control panel connected to the LI terminals of the communicator, to the PSTN
receivers, over the cellular channel, or to IP receiver, over the cellular or Ethernet channel, if CID/SIA Event Conversion is
enabled (see “Phonebook” on page 46).
1.
2.
3.
4.
5.
6.
7.

When an event occurs, the control panel engages the phone line: the communicator simulates the dial tone.
The control panel dials the number of the PSTN receiver: make sure that the control panel inserts at least a 1 second pause
or checks for the dial tone before dialling the number.
The communicator sends the handshake tone required for Contact ID or SIA.
The control panel transmits the message after it has received the handshake.
The communicator forwards the message over the cellular channel to the PSTN receivers or, if enabled, it decodes and
transforms the message into a data packet and sends it to the IP receivers via the cellular or Ethernet channel.
The receiver recognises the message and sends an acknowledgement (kiss-off) to the communicator, which forwards the
kiss-off signal to the control panel.
After the communicator has generated the kiss-off signal, if no other messages are to be sent, the control panel hangs up,
otherwise sends the next event.

SMS message transmission
The communicator may send SMS messages (max. length 70 characters) to previously programmed numbers (up to 8 of the numbers in the communicator’s phonebook) when the events listed in table 11 on page 28 occur and end.

 A SMS is sent when one of the event listed in table 11 on page 28 occurs, for which an SMS has been programmed and at
least one number has been assigned.

Voice message transmission
The communicator may send up to 3 pre-recorded voice messages to previously programmed numbers (up to 8 of the numbers in
the communicator’s phonebook) when the events listed in table 11 on page 28 occur and end. Up to 150 voice messages can be
recorded, of up to 6 seconds each.
A voice call is made when an event occurs for which a voice message has been programmed and which has at least one phone
number. In this case, the communicator executes the procedure indicated below.
1.
2.

3.

4.

The communicator dials the number and makes the call via the PSTN channel, or via the cellular channel if the PSTN line is
missing.
The communicator checks that the number is not engaged and that there are no problems with the cellular network, if the
PSTN line is missing, before proceeding, otherwise it terminates the call and tries step 1 again, for the programmed number
of times (Repeat Call in par. “Communicator Options” on page 62), after which it concludes the call cycle. If the event
has been programmed to call multiple numbers, they are called in sequence. This prevents the system calling an occupied
number several times in a few seconds.
The communicator waits up to 60 seconds for the called number to answer. If the number answers, it goes to step 4,
otherwise it hangs up and tries step 1 again, for the programmed number of times (Repeat Call in par. “Communicator
Options” on page 62), after which it concludes the call cycle.
The communicator plays the message for the event: the call is terminated only after the message has been received, or the
called user presses  on his phone, if the Call Confirmation option is enabled (see “Communicator Options” on
page 62).

If multiple events requiring different messages to be sent to the same number have occurred, the messages are played in sequence, each for the programmed number of Repetitions (see “Communicator Options” on page 62), during a single call, to
avoid calling the same number multiple times.
If, at the end of the call cycle, the event which activated the communicator is still active, the above procedure is not repeated.
The event which tripped the call cycle must first restore before a new cycle of calls is tripped.
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Priority handling
Table 12 lists the actions that the communicator can perform and their priority at default.
The priorities of the communicator’s actions can be set on the console (see “Priorities” on page 50).
Action

Priority

Programmable
on the console

Sending the confirmation ring for communicator’s output activation.

1

Yes

Sending communicator’s Contact ID or SIA messages to PSTN receivers via cellular channel.

2

Yes

Sending communicator’s voice messages via cellular channel.

3

Yes

Sending communicator’s SMS messages via cellular channel.

4

Yes

Sending communicator’s Contact ID or SIA messages to IP receivers via cellular or Ethernet
channel.

5

Yes

Sending communicator’s notifications to the app.

6

Yes

Forwarding voice, Contact ID, or SIA messages of the control panel connected to LI terminals, on the 7
cellular or Ethernet channel.

Yes

Handle incoming SMS.

8

No

Supervision over the cellular data network.

9

No

Table 12 – Action priorities - factory settings.

Notes
 If the communicator is performing an action and another action of higher priority presents, the communicator interrupts the
lower priority action and queues it.
 After the higher priority action has been completed, the communicator tries again to perform the interrupted (queued) action.
 If several actions of the same priority occur together, they are queued and performed in sequence.
 If communicator's voice messages have lower priority than panel messages, when a panel message presents while the
communicator is transmitting a voice message, the communicator hangs up and the panel takes over the line (pick up
detected); after the panel’s message has been completed (hang up detected) the communicator tries again to transmit the
interrupted (queued) message.
 If the communicator's voice messages have higher priority and a panel event occurs while a communicator voice message is
being sent, the communicator must provide the engaged signal to the panel and continue transmitting its messages.
 Communicator SMS have lower priority than control panel actions and the communicator's voice messages, but an SMS
cannot be interrupted while it is being sent.
 The lowest priority is given to data packet transmission for supervision of communications with the IP receivers.
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Pay as you go balance check
If programmed on the Console (see “Pay As You Go Balance” on page 51), you can check your balance on the prepaid SIM
card. Once enabled, the system can check the pay as you go balance in three ways:
1.
2.
3.

On the Console (Status page, only via PC-Link or USB connection).
By SMS to request a response to the sender's number. The command must include the normal user PIN.
An SMS containing the service provider's pay as you go balance information is periodically sent to the first number in the
Phonebook. For all service providers which support pay as you go balance check with network commands, the query string
can entered with the Console.

 At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.
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Panel Transmission Monitoring (PTM)
Constantly controlling communications with the panel (PTM function) enables the communicator to send Contact ID or SIA messages via cellular or Ethernet channel if communications between the panel and the central station via the PSTN line fail. If programmed (on the Console, PSTN/PTM page), this function is only enabled when the PSTN line is connected to terminals LE
and is present.

 Pulse dialing detection is not supported.
When the PTM function activates, the PSTN fault event occurs.
The communicator checks the LE line and, once it has detected that the line is occupied by the panel, executes the following procedure:
 it decodes the dialled number (DTMF);
 if the decoded number has PTM enabled, the communicator check for the Kiss-Off signal (it acknowledges the reception of
the event sent from the panel to the central station).
The panel must make the call immediately: the time between picking up and making the call, programmed on the panel, must be
at least 2 seconds.
If the PTM All Numbers option is enabled (see “PSTN/PTM” on page 71) the communicator will check for the kiss-off for all
calls.
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Activating outputs
The communicator has terminals (T1, T2, T3, T4, T5 and T6) which can be programmed as inputs or outputs. The outputs can be
activated automatically, when certain programmed events occur (see “Inputs/Outputs” on page 55), or remotely, by sending SMS
message to the communicator, by caller recognition from preprogrammed numbers (see “Phonebook” on page 46), or by the a
mobile device running the ConnectAlarm app (see “App Type Output” on page 57).

Remote output activation/deactivation

 The cellular or Ethernet connection must be present for the outputs to be remotely activated or deactivated.
To enable this function, the output must be configured as a Reserved Output.
When terminals T1, T2, T3, T4, T5 and T6 are programmed as outputs, they may be controlled remotely via SMS and Caller ID.
The SMS is never saved to the device, but is deleted as soon as the command has been executed.
The number used to activate the outputs using Caller ID must NOT be concealed (it must NOT be a private number).
To avoid calls being forwarded to devices connected to terminals LI, we recommend the communicator is programmed with
the Black List Enabled enabled (Options > Dial Options) and White list disabled (Phonebook) for the numbers you
wish to use for this function, calls will be rejected in this way.
The Open-Collector outputs can be programmed as Bistable or Monostable:
 Bistable outputs are activated/deactivated with two separate commands;
 Monostable outputs stay active for the programmed Monostable Time On, after which they return to standby, or until
they are deactivated by SMS.
Each output can be programmed to return a confirm signal:
 a previously programmed SMS, if the output was activated/deactivated via SMS;
 a confirm ringtone, if Caller ID was used.

 If Caller ID is used, the call hangs up automatically 12 seconds after the output is activated.
For further details on the Control String and User Code options used in the following paragraphs, refer to paragraphs
“Inputs/Outputs” on page 55 and “Options” on page 49.

Bistable outputs
Open Collector outputs configured to be bistable may be activated in two ways:
1.

By sending an SMS consisting of the pound (#), the User Code, the Control String (Control String can not have initial
blank spaces) and the characters =ON*, as follows:
#User Code*Control String=ON* (example: #123456*HOMELIGHT=ON*)

2.

Using Caller ID: in this case, the output is activated without charge, since once the device has recognised the caller, it
activates the output without accepting the call.

 An OC output configured as bistable can ONLY be deactivated by an SMS composed of the pound (#), the User Code, the
Control String and the characters =OFF* using the following syntax:
#User Code*Control String=OFF* (example: #123456*HOMELIGHT=OFF*)

 The 6 digit user code is factory set to 000000; to replace it, see “Changing the user code” on page 37.
Monostable outputs
OC outputs configured as monostable can be activated in 2 ways: by SMS and using Caller ID.
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SMS
Send an SMS composed of the pound (#), the User Code, the Control String (Control String can not have initial blank spaces)
and by the characters =ON*, =ON*TonU* or =OFF* using the following syntax:
#User Code*Control String=ON*
#User Code*Control String=ON*TonU*
#User Code*Control String=OFF*
The =ON*TonU* parameter sets the ON time from 1 to 86400 seconds, with a resolution of 1 second. The ON Time can be set
by means of the Communicator's Console software. Ton is the required value and U is the unit in hours (H), minutes (M) and
seconds (S), as shown in the following example:
SMS Example

Effect

#123456*HOMELIGHT=ON*

Bistable activation.

#123456*HOMELIGHT=ON**

Activated as programmed.

#123456*HOMELIGHT=ON*3600S*

Active for 3600 seconds.

#123456*HOMELIGHT=ON*50M*

Active for 50 minutes.

#123456*HOMELIGHT=ON*3600*

Activated as programmed, the invalid ON time parameter is ignored.

#123456*HOMELIGHT=ON*000S*

Activated as programmed, the invalid ON time parameter is ignored.

#123456*HOMELIGHT=OFF*

Deactivated.

 To activate the output with an SMS using the programmed settings, remove the parameter TonU and leave the characters **.
(Example: #9876*HOMELIGHT=ON**).
If the monostable output is programmed incorrectly, the output will be activated for the Monostable Time On set in the
Console.

Caller ID
The output is activated free of charge, since after it has recognised the caller, the device activates the output without answering
the call.

 Monostable outputs return to standby after the programmed Monostable Time On.
The Monostable Time On can be set from 1 second to 86400 seconds, with a 1 second resolution.
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SMS Programming
In addition to the processes described in the paragraph “Remote output activation/deactivation” on page 35, it is also possible to
carry out other remote procedures through the transmission of various SMS messages.

Changing the user code
The default user code is 000000; to change it, send an SMS message consisting of the characters #CUC followed by the current
user code and the new user code between * characters, in accordance with the following formula:
#CUC*User code*New user code*
The device will send an SMS to confirm that the user code has changed.

 The new user code must be 6 digits long (0-9).
Enabling/disabling remote programming
Remote programming allows you to operate the Console over a network. To set the communicator's parameters remotely, you must
enable remote programming, either with the Console (see “Network Settings” on page 52), or with an SMS composed of the characters #ERA followed by the User Code and ON enclosed in * as follows:
#ERA*User code*ON*
To disable remote programming, send the following SMS:
#ERA*User code*OFF*
The device will confirm with an SMS.

Changing the installer code
The 6-digit installer code is used to access the remote programming interface (see “Installer Authentication” on page 49). The
default installer code is 111111; to change it, send an SMS message consisting of the characters #CIC followed by the current
Installer code and the new Installer code between * characters, in accordance with the following formula:
#CIC*Installer code*New installer code*

 The new installer code must be 6 digits long (0-9).
If the EN50136 option is enabled, the installer must be authorised by the normal user for the installer code change to
take effect.
The device will send an SMS to confirm that the installer code has changed.

Changing the level 4 installer code
The default level 4 installer code is 222222; to change it, send an SMS composed of the characters #CMC followed by the current
Level 4 Installer code and the new Level 4 Installer code enclosed between *, as follows:
#CMC*Level 4 installer code*New level 4 installer code*

 The new level 4 installer code must be 6 digits long (0-9).
For the Level 4 installer code change to take effect, the Level 4 installer must be authorised by the installer.
The device will send an SMS to confirm that the level 4 installer code has changed.
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Pay as you go balance check
To check your pay as you go balance with an SMS, you can either use the Console (see “Pay As You Go Balance” on page 51)
or send an SMS composed of the characters #CCC followed by * and the user code, as follows:
#CCC*User code*
or #ICCC followed by * and the installer code, as follows:
#ICCC*Installer code*

 You will receive an SMS with the pay as you go balance.
At the mobile service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.
If the EN50136 option is enabled, the installer must be authorised by the normal user for the command to work.

Checking the expiration date
To find out the expiration date of the SIM card with an SMS, send an SMS composed of the characters #EDC followed by * and
user code, as follows:
#EDC*User code*
You will receive an SMS with the expiration date.

Updating the expiration date
To update the SIM card's expiration date with an SMS, send an SMS composed of the characters #EDU followed by *, the user
code and the new date, as follows:
#EDU*User code*new date*
The date must have the format DD/MM/YYYY.

 If an expiration date has NEVER been set on the Console, the expiration time is set to 10:00 AM.
If a date and time of expiration have been set with the Console and you then change the expiration date with an SMS using
the command #EDU, the expiration time is unchanged.

Checking the serial number
This command is used to check the communicator's serial number with an SMS composed of the characters #RID followed by *
and the user code, as follows:
#RID*User code*
or #IRID followed by * and the installer code, as follows:
#IRID*Installer code*
The device will respond with the RID: 01234567.

Enabling the installer
To enable the installer to work with the device, the user must send a SMS composed of #ENI followed by the User code as follows:
#ENI*User code*
The device will confirm with an SMS.

 The installer must be enabled only if the EN 50136 option is enabled; if not, the installer is always enabled.
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Disabling the installer
To disable the installer from working with the device, the user must send a SMS composed of #DSI followed by the User code as
follows:
#DSI*User code*
The device will confirm with an SMS.

 The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.

Enabling the level 4 installer
To enable the level 4 installer to work with the device, the installer must send a SMS composed of #ENM followed by the Installer
code as follows:
#ENM*Installer code*
The device will confirm with an SMS.
The level 4 installer is automatically disabled after 12 hours.

Start a remote session
To start a remote communicator session, send an SMS composed of #SRS followed by the Console IP and the Console port
between *, as follows:
#SRS*Console IP* Console port*
where:
 the Console IP if the public IP of the PC in the format “AAA.BBB.CCC.DDD” (e.g. 37.207.123.181) or host/domain name
format (Fully Qualified Domain Name, e.g. “my_name.dyndns.org”);
 the Console port is the IP port in the format “NNNNN” (a 5 digit number in the range 1 to 65535).

 You must set the router to which the Console's PC is connected to enable port forwarding from the Console port to TCP port
51004 (the port used locally by the Console, this is NOT editable): ask your network administrator or refer to the router's
instructions.
The APN specified in the Console Network Settings page will be used, or the one programmed for Receiver 1 (IP Receivers
page).
If no APN has been programmed (neither in the Network Settings page nor in the IP Receivers page), the SMS must specify
the connection as follows:
#SRS*Console IP*Console port*APN access point name*
In some cases, if the APN USERNAME (max 32 characters) and PASSWORD (max 32 characters) are set, the above string is
sufficient to initiate a session, otherwise the string must be modified as follows:
#SRS*Console IP*Console port*APN access point name*User name*Password*

Changing the account number for the cellular receiver
To change the account number sent to the cellular receiver, send an SMS composed of #ACNC followed by the Installer Code
and the Account number between *, as follow:
#ACNC*Installer code*Account number*
where:
 the Account number is a maximum of 10 digits.
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Changing the account number for the Ethernet receiver
To change the account number sent to the Ethernet receiver, send an SMS composed of #ACNE followed by the Installer Code
and the Account number between *, as follow:
#ACNE*Installer code*Account number*
where:
the Account number is a maximum of 10 digits.
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ConnectAlarm app
Using the ConnectAlarm app on an Andorid/iOS mobile device, you can:
 Activate or deactivate the communicator’s outputs (see “App Type Output” on page 57);
 Display the status of the communicator’s input (see “App Type Input” on page 58);
 Display text messages when the communicator’s events occur and end (see SMS / Push Notifications in “Inputs and
Events” on page 63);
 Display the Contact ID messages from the communicator (see Central Station Calls in “Inputs and Events” on page 63);
 Display text messages for Contact ID and SIA messages of control panel connected to the communicator’s LI terminals (see
SMS / Push Notifications in “CID/SIA Converter” on page 64);
 Display the Contact ID messages from the control panel connected to the communicator’s LI terminals (see All CID
Events to App Server in “App Server” on page 53).

 The app deletes all event notifications related to a class (alarm, tamper, fault) when an event of that class restores. You can
see active events through the button for event display.

Setting up the ConnectAlarm app

1.
2.

3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.

On your mobile device, download the ConnectAlarm app from Play Store or Apple Store.
Open the ConnectAlarm app: the first time you open the ConnectAlarm app you must read and accept the End User
License Agreement and the Privacy Notice.
Enter the Server Address, connect.tycomonitor.com, and click OK.
Click Sign up.
Enter a valid E-mail address and click SIGN UP.
Enter the E-mail code you received at the e-mail address you have entered in previous step and click PROCEED.
Enter the password for your account and click PROCEED.
In the Panel name option, enter a name for the system where the communicator is part.
In the Panel Serial option, enter the communicator serial number on the communicator electronic board.
In the Master User Code option, enter the communicator’s user code (see Options > User Authentication > User
Code in the console): default, 000000.
Click CONNECT.
In the PANELS LIST, select the system you have had just added.
Enter the communicator’s user code (see Options > User Authentication > User Code in the console) and click
PROCEED: default 000000.

At this point the end user can manage the system, according to the installer setup.
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PC PROGRAMMING
You can program the communicator using the latest DLS 5 console software that you can download from www.dsc.com.

 To install and run the console, you must have admin rights on the PC; we also recommend that you check the firewall settings
if you encounter problems during the installation procedure.
Proceed as outlined below.
1.
2.
3.
4.
5.
6.

Install the console.
Run the console.
Select the user name and enter the password to enter the session: the factory setting uses the username admin and the
password is 1234.
Open the File menu and click on New Account to create a new account or open an account listed in the Start Page:
double click on the account to open it.
Setup the options (refer to the respective paragraphs for instructions).
Download the options to the communicator (refer to “Downloading and Uploading” on page 76).

 To change the console's language, click on Tools > Edit Current User; select the language on the next page.
Description of the menus











File menu
New Account: Creates a new account and assigns the factory settings to all parameters.
Account Group Maintenance: groups several accounts into a group.
Recent Files: selects an existing account.
Exit: Exits the program. You will be prompted to save any changes made to the current installation.
View menu
Start Page: equivalent to clicking on the Start Page tab.
Toolbar: opens the Account Group Maintenance field.
Operators Online: list of connected users.
Open Accounts: list of saved accounts.







Communication Jobs: lists the communication sessions; you can also click on
.
Recent Activity: list of recent activity.
Tools menu
Language Manager: modifies, imports/exports, creates new languages.
DLS 5 v1.50 Operator Maintenance: in this window, the administrator can modify his password and set the password
for a user (with possible functional restrictions—Edit Operator Roles) for the Console.
Modem Manager Configuration: sets the type of connection: PCLINK or COM port.
Edit Current Operator: see previous page for changing the Console language.
Backup/Restore Database: sets the database management options.
Recycle Bin: select the account and delete it.
Window menu
Close All Tabs: closes all open account tabs.
Start Page: equivalent to clicking on the Start Page tab.
Help menu
About DLS: displays the Console version.
End User License Agreement: displays the text of the license agreement.
Updates: Check For Updates—Show Installed Updates—Manually Install Update.
Send Feedback: send a comment to the manufacturer
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Description of icons
Global Upload: displays the communicator's settings on the PC.
Global Download: once a new account has been programmed (or an existing account has been modified), sends the new
settings to the communicator.
Save: if you change the settings for the existing account, click on Save to save the new configuration.
Connect Only.
Communicate Tags.
Upload Event Log.
Clear all tags.
Disconnect When Complete.
Programming/Audio Import/Export.
Select User: displays only information relating to the Normal User, Installer or Level4 Installer.
Option Name Search: enter the name of the option to the left of the icon.
Icons present on all programming pages.
Clear all tags for this group.
Export.
Restore all options to default.
Restore all options to original.
Tag all for upload: select all page options for upload.
Tag all for download: select all page options for download.
The following pages are available in the programming section.
Phonebook: the phonebook page.
Options: options page.
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Firmware Update: the icon only displays when the Level 4 Installer is enabled and is updating the firmware in this page
(see icon Select User).
Network Settings: connection settings page
Inputs/Outputs: programs the communicator's inputs and outputs.
Communicator: communicator programming page.
IP Receivers: programs all IP receiver options.
Voice Messages: voice message management page.
PSTN/PTM: configures the PTM function.
Event Log: configures the event buffer.
Status: communicator monitoring page.
If you wish to configure a new account, go to File > New Account.
To display the list of accounts in the database, select View > Start Page or click on Start Page. In this section you can delete
or recall the configuration for a given account as follows:
1.
2.

Right click on the account name.
Select Open to load the data from the database or Delete to delete the account and all its settings from the database.

To load an account, you can simply double-click on the account name.
You can also order the list alphabetically or by code by clicking on the header of the column in question.
All settings are available on the following pages. This chapter describes in detail the application's pages.

 Depending on your level of access (Normal User, Installer or Level 4 Installer) the settings pages will display differently.
Programming/Audio Import/Export
Button

opens a window with the following functions.
Export Programming: click on this button to export the current settings from the Console to a USB key.

Import Programming: click on this button to import a communicator's settings from a USB key to the Console; the
settings may be those previously exported from a Console running on another PC, or from a communicator.
Export Audio: click on this button to export the voice messages from the Console to a USB key.

Import Audio: click on this button to import the voice messages from a USB key to the Console; the messages may
be those previously exported from a Console running on another PC, or from a communicator.
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Restore Factory Settings
To restore the communicator's factory settings, proceed as follows.
1.
2.
3.
4.

Shut off power to the communicator.
Short pins 1 and 4 of the PC LINK 15 connector and restore power.
All LEDs will turn on, and after a few seconds the green ones will turn off to indicate that the factory restore is in progress.
You can now remove the short connection between pins 1 and 4 of connector 15.

5.

Once the procedure terminates, the LEDs
other LEDs remain off.

will flash to indicate that the PINs have been restored to their values; the

 Recorded voice messages are NOT deleted by the factory restore procedure. Voice messages can be deleted in the Console's
Voice Messages page.
The factory restore procedure may NOT be executed if the communicator is ONLY powered by its backup battery; you must
reconnect its primary power supply.
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Phonebook
You can save up to 32 phone numbers in this page.

 If the periodic pay as you go balance function has been programmed for the communicator's SIM card (see the Options page)
the answering SMS is sent to phone number #1.
 Label: enter an alphanumeric string of at most 16 characters.
 Phone Number: enter a phone number with the international dialing prefix in the format “+xxx” (e.g.: +39 for Italy). Up to
16 digits at most are allowed (the “+” counts as a character).

 The numbers in the phonebook are used to activate outputs, for the SMS communicator, the voice communicator, the
IP receiver and for PTM (Panel Transmission Monitoring).
 White List: if Black List Enabled option is enabled (see Options > Dialing Options) the communicator will forward
to devices connected to terminals LI (e.g. a burglar alarm panel or a telephone set) the calls coming from numbers with this
option enabled and will block calls coming from all other numbers, as explained by the following table.
Black List Enabled
Disabled

Operating Mode

White List
Disabled

Incoming calls from any number are forwarded to LI.

Disabled

Enabled

Incoming calls from any number are forwarded to LI.

Enabled

Disabled

Incoming calls from any number are blocked.

Enabled

Enabled

ONLY incoming calls from numbers with White List option enabled are
forwarded to LI; incoming calls from any other number blocked.

 This option affects ONLY calls over cellular channel; incoming calls to communicator's terminals LE are ALWAYS forwarded
to terminals LI.

 Numbers having the White List option enabled must have Caller ID enabled otherwise the communicator blocks the call.
 Activate Output: click on [+] to select the outputs (1 = T1, 2 = T2, 3 = T3, 4 = T4, 5 = T5 and 6 = T6) to activate when the
communicator receives a call from the number in question. This function is independent of the White List and Black List
Enabled settings in Options > Dialing Options. To activate the output, Caller ID must be enabled, for the number in
question.

 To activate the output, set terminal T1, T2, T3, T4, T5 or T6 as Output and enable Reserved Output option (see Inputs/
Outputs page).
 Output Activation Confirmation: check this box to receive a ring tone to confirm activation of the output.

 The ringtone will sound 1 minute after the output has been activated.
If the communicator is busy with another operation (for example, the cellular channel is busy with voice communications),
the ringtone will not be sent.
 PTM: enable this options to activate the “PTM” function for the number in question. Use this option to monitor the panel's
calls to a PSTN receiver's number (central station). Factory setting: disabled.
 CID/SIA Event Conversion: enables sending of messages by voice or SMS, by decoding the panel's CID/SIA packets
(see table 13 on page 47).
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 Virtual Receiver on GSM Path: if CID/SIA Event Conversion is enabled and the option IP Receiver on GSM
Path is disabled, this function forces the communicator to simulate a receiver (the communicator sends a handshake and
kissoff to the panel).
 IP Receiver on GSM Path: enables decoding of events transmitted by the panel to the phone number and the
transmission of events on the cellular network to IP receivers (central station).

Channel1

Communication
protocol2

CID/SIA
Virtual IP Receiver
Event
Receiver on on GSM
Conversion GSM Path
Path

PSTN

No effect

Disabled

No effect

No effect

The panel's voice and digital messages (SIA and
CID) are forwarded to PSTN.

PSTN

SIA / Contact ID Enabled

No effect

No effect

The panel's voice and digital messages are
forwarded to PSTN.
The digital messages are converted to voice or
SMS messages (as set in the Communicator >
CID/SIA Converter page) and forwarded on
cellular channel3.

Cellular

No effect

Disabled

Disabled

Disabled

The panel's voice messages are forwarded on
cellular channel4.

Cellular

Contact ID

Enabled

Disabled

Disabled

The panel's voice and digital messages (CID) are
forwarded on cellular channel4.
The digital messages (CID) are converted to voice
or SMS messages (as set in the Communicator
> CID/SIA Converter page) and forwarded
on cellular channel3.

Cellular

SIA / Contact ID Enabled

Enabled

Disabled

The digital messages (CID or SIA) are converted
to voice or SMS messages (as set in the
Communicator > CID/SIA Converter page)
and forwarded on cellular channel3.
The communicator simulates a receiver by
supplying the handshake and kissoff messages.

Cellular or SIA / Contact ID Disabled
Ethernet

Disabled

Enabled

The digital messages (CID or SIA) are decoded
and forwarded on the cellular or Ethernet channel
to the IP receivers.
The communicator simulates a receiver by
supplying the handshake and kissoff messages.

Effects

Table 13 – Effects of the CID/SIA Event Conversion, Virtual Receiver on GSM Path and IP Receiver on GSM Path
options on the communicator's operation.
1) Refers to the communications channel used by the communicator.
2) See the Options page.
3) Only if the panel's communications protocol is compatible with that of the communicator.
4) SIA and CID messages may NOT be understood by the receivers due to distortion on the cellular network.
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Channel1

Communication
protocol2

CID/SIA
Virtual IP Receiver
Event
Receiver on on GSM
Conversion GSM Path
Path

Cellular or SIA / Contact ID Enabled
Ethernet

Disabled

Enabled

Effects
The digital messages (CID or SIA) are decoded
and forwarded on the cellular or Ethernet channel
to the IP receivers.
The communicator simulates a receiver by
supplying the handshake and kissoff messages.
The digital messages (CID or SIA) are converted
to voice or SMS messages (as set in the
Communicator > CID/SIA Converter page)
and forwarded on cellular channel3.

Table 13 – Effects of the CID/SIA Event Conversion, Virtual Receiver on GSM Path and IP Receiver on GSM Path
options on the communicator's operation.
1) Refers to the communications channel used by the communicator.
2) See the Options page.
3) Only if the panel's communications protocol is compatible with that of the communicator.
4) SIA and CID messages may NOT be understood by the receivers due to distortion on the cellular network.
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Options

 The Options page differs depending on the user's access level: normal user, installer, level 4 installer.
User Authentication
 Installer Code Enabled: the normal user uses this option to enable the installer for programming the communicator.

 The installer need only be enabled if the EN50136 option is enabled.
The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.
 User Code: enter the normal user code here (at most 6 digits), for use, among others, in remotely activating the outputs.
Factory setting: 000000.

Installer Authentication
 Installer Code: enter the installer code here (6 digits). Factory setting: 111111.
 Level 4 Installer Code Enabled: the installer can enable the level 4 installer code for communicator firmware updates
here.

 This option is disabled if the EN50136 option is disabled.
 EN50136: the installer can enable/disable the EN50136 option in this box.

 To ensure conformity with EN 50136-2, the EN50136 option should NOT be disabled.
Level 4 Installer Authentication
 Level 4 Installer Code: enter the level 4 installer code here (6 digits). This code gives access to firmware updates and
Status page display. Factory setting: 222222.

Dialing Options
This section configures certain aspects of the phone numbers.
 Dial Prefix: the number entered in this box is placed before any number dialled by the communicator over the cellular
channel. Enter the prefix (1 to 8 digits) or leave the field empty, if unused.
 Digits to Remove: if the communicator is connected to a phone switchboard, the phone numbers (programmed in the
panel) must be preceded by the switchboard number (normally a single digit). Since the switchboard number is not
necessary when calls are made to the GSM network, it must be removed from the number. Enter the number of digits that
form the switchboard number (e.g. if switchboard number is 01, enter 2 in the Digits to Remove option, as 2 numbers form
the switchboard number).

 The phone number must have at least two digits more than the number entered in Digits to Remove, otherwise the engaged
tone is generated.
Example:
1.
2.
3.

Set the Dial Prefix = 9999 and set Digits to Remove to 2 on the communicator.
Configure a voice call on the panel using the number 9999011234567890.
Activate the call on the panel.
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4.

The communicator will send the call to the number 1234567890.

 If the Digits to Remove option is enabled and the panel calls a number which has CID/SIA Event Conversion enabled
(see Phonebook), the phone number in the phonebook must match the one programmed on the panel (including prefix), in
order for the communicator to convert it.
 Black List Enabled: if enabled, the communicator forwards to devices connected to terminals LI, the calls coming from
telephone numbers with White List option is enabled ONLY (see “Phonebook” on page 46).

 This option affect ONLY calls over the cellular channel; incoming calls to communicator's terminals LE are ALWAYS
forwarded to terminals LI.

 The Black List function COMBINED with Activate Output on Caller ID delays call refusal by a few seconds. The
confirmation ring tone associated with Activate Output on Caller ID delays call refusal by a few seconds. If the call is refused
immediately, the output has not been activated.
 Tones: select the country of Communicator installation; the selected country will set adequately a series of parameters for
the proper working of the simulated telephone line.
 Roaming Enabled: enables the communicator to connect to another mobile service provider when that of communicator’s
SIM is not available.

 Additional charges may apply.
Priorities
This options allows you to configure the communicator’s actions priority.
 Dialer / LI Priority: defines the priority of the communicator actions (see Dialer Events Priority) and the LI
(messages transmitted by devices connected to the LI terminals, such as a burglar alarm panel).
Factory setting: Dialer High, LI low.








Dialer Events Priority: set the priority for the communicator’s actions described as follow.
Digital Calls: Sending the communicator’s Contact ID or SIA messages to PSTN receivers via cellular channel.
Push Application: Sending the communicator’s notifications to the app.
Ring: Sending the confirmation ring for communicator’s output activation.
Rx: Sending the communicator’s Contact ID or SIA messages to IP receivers via cellular or Ethernet channel.
SMS: Sending the communicator’s SMS messages via cellular channel.
Voice Calls: the Sending communicator’s voice messages via cellular channel.

Factory setting: 1:Ring; 2:Digital Calls; 3:Voice Calls; 4:SMS; 5:Rx; 6:Push Application.

Generic
This section sets the loudness of the communicator's speaker and microphone.
 Speaker Volume: set the communicator's speaker volume: change this setting if the panel connected to terminals LI of the
communicator is unable to decode the DTMF commands.
 Microphone Volume: set the communicator's microphone volume: change this setting if the user is unable to understand
the voice messages sent by the panel connected to terminals LI of the communicator or by the communicator itself.

 A high microphone volume setting can corrupt the DTMF tones from devices connected to terminals LI, and make them
incomprehensible.
 Enable Antenna Cut Detection: if enabled, the Antenna Fault event is tripped when the antenna is not present or in
short circuit.
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 Enable Battery Detection: if enabled, the Battery Fault event is tripped when battery faults are detected.

Automatic Clock Adjust
The options of this section is for the automatic synchronisation of the communicator's clock.
 SIM Phone Number: enter the phone number of the SIM card in the communicator (up to 16 digits).
 Auto SMS: if enabled, the communicator updates the system date and time by sending an SMS to the number specified in
the SIM Phone Number option. Factory setting: enabled.
 IP Clock Adjust: if enabled, the communicator gets the date and time from the IP receiver 1, when configured and
connected. Factory setting: enabled.

 In order to ensure compliance with EN 50136-2, the Auto SMS and IP Clock Adjust options must be enabled.
Pay As You Go Balance

 At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.
This section configures the system so that an SMS containing the service provider's pay as you go balance information is periodically sent to the first number in the Phonebook. Program the following options for a proper pay as you go balance request, depending on the service provider in question.

 Check with the SIM card provider for the methods and any charges for the available credit request.
 Enquiry Type: select the type of request (none, SMS, Call, Service Command).
 Enquiry Number: telephone number to call or to which an SMS message should be sent in order to request credit balance
information.
 Balance Message: string used in the SMS requesting the balance using network commands.
 Enquiry Interval: enter the interval within which the periodic SMS is to be sent with the balance information (if handled by
the operator). The interval is composed of the following values:
— Days, day of next send—select to send the next periodic SMS. The value runs from 0 to 364;
— Hours, time of next send—select to send the next periodic SMS. The value runs from 0 to 23.

SIM Expiration
 SIM Expiration Message: enables sending the SMS (user programmable) with the expiration data to the first number in
the phonebook.
 SIM Expiration Date: once the expiration date is set, the message is sent 30, 15, 7, 6, 5, 4, 3, 2 and 1 days prior to the
expiry date itself. Click on Now to set the PC's time.

 The SMS is sent once every programmed day: if it fails, no further attempt is done.
Protocol Settings
 Handshake Repetition: set the number of handshakes generated by the communicator and sent to the panel connected
to terminals LI. Range: 1 to 4.
 Communication protocol: select the protocol: Contact ID or SIA.

 Depending on this setting, the communicator will decode CID or SIA events from the panel connected to the LI line; the setting
must be the same for all numbers handled by the communicator.
The installer must check that the mobile service operator works reliably with Contact ID on the cellular network, due to issues
with transmission quality.
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Network Settings
The Network Settings page is to setup the communicator for communication via cellular network or via Ethernet, with the console
or the app, as indicated following.
 Device ID: enter the communicator's serial number you can find on the communicator’s electronic board.

Cellular Data
The options in the Cellular Data section are to setup the communicator for communication via cellular network.
In order to set up a cellular communication, the user must specify an APN, optionally a user name and password, provided by the
network operator, as indicated following.





Remote Access: check this box to enable remote programming.
Remote Access APN: access point name, up to 32 characters. This is generally supplied by the cellular network operator.
Remote Access User Name: some operators require user authentication; enter the user name in this field.
Remote Access Password: enter the password in this field.

 See paragraph “Start a remote session” on page 39.
Ethernet
The options in the Ethernet section are to setup the communicator for communication via Ethernet, as indicated following.
 Obtain an IP address automatically: If this option is ENABLED the server or router the communicator is connected to
provides the communicator with the information required to connect to the sub-network it is part of: IP Address, Subnet
Mask, Default Gateway, DNS Server Address.
If this option is disabled the connection options should be set manually as described in the following sections. Factory setting:
enabled.
 IP Address: Enter the IP address1 to be assigned to the communicator: the network administrator will provide this
information. Factory setting: 192.168.0.101

 This option is locked if the Obtain an IP address automatically option is enabled.
 Subnet Mask: Enter the sub-network mask2 for the local sub-network: the network administrator will provide this
information. Factory setting: 255.255.255.0.

 This option is locked if the Obtain an IP address automatically option is enabled.
 Default Gateway: Enter the IP address for the local gateway3 that will be used by the communicator to connect to a PC
outside the LAN (Ethernet): the network administrator will provide this information. Factory setting: 192.168.0.1.

 This option is locked if the Obtain an IP address automatically option is enabled.
1.

2.

3.
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An Internet protocol (IP) address is a numerical label that uniquely identifies a device (host) connected to a computer network that uses Internet Protocol as a communication protocol. An IP address basically performs two main
functions: it identifies a device on the network and consequently provides the path for it to reach another device on
the network.
The sub-network mask indicates the method used to define the given range for a host within an IP sub-network, in
order to reduce network traffic and assist in searching for and reaching a determined host with relevant sub-network IP address.
A gateway is a network device whose main function is to carry network data packets outside to a local network
(LAN); the hardware device that implements this task is usually a router.
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 DNS Server Address: Enter the IP address for the DNS server: the network administrator will provide this information.
Factory setting: 8.8.8.8 (google).

 This option is locked if the Obtain an IP address automatically option is enabled.







Ethernet speed configuration: Select the Ethernet interface speed for the communicator.
Automatic (factory setting);
10 Mbps, Half Duplex;
100 Mbps, Half Duplex;
10 Mbps, Full Duplex;
100 Mbps, Full Duplex.

App Server
The options in the App Server section are to setup the communicator for communication with the app over the cellular or Ethernet
channel, as indicated following.
 IP address: This is the IP address of the app server set in factory. Change this IP address if required. It can be numeric or
literal value.
 Ethernet Remote Port: This is the listening port used by the app server over the Ethernet channel. Change this port only
if required by the app server. In any case, it must be different from receivers’ remote ports and from Cellular Remote
Port. Factory setting: 1303.
 Cellular Remote Port: This is the listening port used by the app server over the cellular channel. Change this port only if
required by the app server. In any case, it must be different from receivers’ remote ports and from Ethernet Remote Port.
Factory setting: 1304.
 Eth/Cellular Local Outgoing Port: This is the outgoing port used by the communicator to communicate with the app
server. Zero means that the communicator automatically set this value. Enter a fixed value if the local network rules block
some outgoing port. If you enter a value different from zero, it must be different from the Eth/Cellular Local Outgoing
Port set for DLS. Factory setting: 0.
 Channel Priority: Select the channel used by the communicator for communication with the app server.
 Cellular Only: the communicator uses the cellular channel for communication with the app server.
 Ethernet Only: the communicator uses the Ethernet channel for communication with the app server.
 Ethernet Primary, Cellular Backup: the communicator uses the Ethernet channel for communication with the app
server, and the cellular channel when the Ethernet communication is missing.
Factory setting: Cellular Only.
 All CID Events to App Server: If enabled, all the Contact ID events of the panel connected to the communicator are
forwarded to the app. Factory setting: disabled.
 Ethernet Init encryption key: This is the encryption key used on the first communication with the app server, on the
Ethernet channel. Change this encryption key only if required by the app server. Factory setting:
12345678123456781234567812345678.
 Cellular Init encryption key: This is the encryption key used on the first communication with the app server, on the
cellular channel. Change this encryption key only if required by the app server. Factory setting:
12345678123456781234567812345678.

DLS
The options in the DLS section are to setup the communicator for communication with the console, as indicated following.
 Ethernet Local Incoming Port: Enter the incoming port on the communicator for the console connecting as client.
Factory setting: 3062.
 Eth/Cellular Local Outgoing Port: This is the outgoing port used by the communicator to communicate with the
console. Zero means that the communicator automatically set this value. Enter a fixed value if the local network rules block
some outgoing port. If you enter a value different from zero, it must be different from the Eth/Cellular Local Outgoing
Port set for App Server. Factory setting: 0.
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 Outgoing Connect. Fallback to Cellular: if this option is enabled, the communicator tries the connection through
cellular network if the Ethernet connection fails. Factory setting: disabled.
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Inputs/Outputs
This page is used for setting the input/output modes, the output activation events, their standby polarity (NC or NO), the reserved
outputs, and the remote activation SMS strings for the reserved outputs.
 Template: you can set the communicator’s inputs and outputs to manage control panels or appliances, through the
ConnectAlarm app (see “App Type Output” on page 57 and “App Type Input” on page 58). This menu has a list of presets suitable for managing specific control panels.
 Custom: you can set all the inputs and outputs options as required.
 PowerSeries: input and output options are set to manage a PowerSeries control panel.
 PowerNeo: input and output options are set to manage a PowerNeo control panel.
 Kyo32G: input and output options are set to manage the Kyo32G control panel.
 Kyo320: input and output options are set to manage the Kyo320 control panel. The control panel may be connected to the
communicator as shown in figure 7.

A

L1
L2
O1
O2
O3
O4

T1
T2
T3
T4 B
T5
T6

Figure 7 – Wiring diagram example for managing the Kyo320 control panel through the ConnectAlarm app. Note: In your
installation, the control panel terminals may be different.
Callout

Description

A

Control panel.

B

Communicator.

L1

Input that arms the control panel when connected to negative.

L2

Input that disarm the control panel when connected to negative.

O1

Output floating when the control panel is disarmed, connected to negative when the control panel is
armed.

O2

Output connected to negative when the control panel is in alarm status.

O3

Output connected to negative when the control panel is in tamper status.

O4

Output connected to negative when the control panel is in fault status.
Negative terminal.

 Input/output: double click on the input/output number to view the settings.
 Label: enter an alphanumeric string of at most 16 characters.
 I/O Type: in this column you can program terminals T1, T2, T3, T4, T5 and T6 for the following modes:
— Input, select this mode to configure the terminal as an input line;
— Output, select this mode to configure the terminal as an open-collector output;
 Polarity: this option is used to program the output/input standby status:
— Normally Closed: the terminal is grounded (negative) when the input/output is at standby;
— Normally Open: the terminal is floating when the input/output is at standby.
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 Output: if set as output, double click on [+] to display the column relating to the event to program for the output. The check
mark indicates that the output in question will be activated when the event occurs. Click on the boxes to check/uncheck them.

 An output returns to standby when all the causes that tripped it are resolved, except for FTC fault, in which case it returns
to standby after a set delay (ON time).

 Programming events for an output implies that certain events relating to the output are disabled.
 Panel Interconnection Fault: if selected, the output is activated when the panel is not present.
 Jamming Detect: if selected, the output will be activated if the device is subject to radio disturbance (factory setting:
terminal T6).
 Antenna Fault: if selected, the output is activated if the antenna is not present or has limited function (only with ANTLTE02).
 Tampers: if selected, the output will be activated when tampering is detected: opening the cover, removal from the wall
(factory setting: terminal T4 on GS4005/3G4005/TL405LE or T6 on GS4015).
 PSTN Fault: if selected, the output is activated if the external phone line, connected to the LE terminals, fails (factory
setting: terminal T1 on GS4005/3G4005/TL405LE or T4 on GS4015).
 GSM Fault: if selected, the output is activated if cellular network coverage fails (factory setting: terminal T5).
 No Cellular Network: if selected, the output is activated when problems occur with the cellular network connection
(factory setting: terminal T2 on GS4005/3G4005/TL405LE or T5 on GS4015).
 IP Receiver Fail: if selected, the output is activated whenever a problem occurs with the IP receiver.
 FTC Fault: if selected, the output is activated when a phone action does NOT terminate successfully and returns to
standby when the most recent phone action terminates successfully.
 Ethernet DoS Detected Fault: if selected, the communicator activates the output when detects a DoS attack on the
Ethernet channel.
 Ethernet Network Fault: if selected, the communicator activates the output when does NOT see the LAN network.
 Power Fault: if selected, the output is activated when a power problem is detected.
 Reserved Output: if selected the output may be activated by Caller ID or SMS.

 If the Reserved Output option is enabled, all other options are disabled.
 Control String: in this option, enter the string (maximum 16 alphanumeric characters) to be sent by SMS when you wish to
activate/deactivate the corresponding output remotely. This function is available even if Caller ID is not enabled.
 Activation Confirmation: select the type of confirmation you want to receive when the output is activated: none, Ring,
SMS (NOT available when the Control String option is left blank) and Ring + SMS. If the output is activated by an SMS,
the activation confirmation will be sent by SMS (see table below).
SETTINGS
Black List
White List
Enabled

EFFECTS
Activation
Call Forwarded
Confirmation
Confirmation (only if the communicator is switched to cellular channel)
Ring

Disabled

Disabled

None

YES

NO

Disabled

Disabled

Ring

NO

YES

Disabled

Enabled

None

YES

NO

Disabled

Enabled

Ring

NO

YES
NO

Enabled

Disabled

None

NO

Enabled

Disabled

Ring

NO

YES

Enabled

Enabled

None

YES

NO

Enabled

Enabled

Ring

NO

YES
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 Type: normally the outputs, when activated, remain so until a deactivation command is received (Bistable), at which point
the output will revert to its standby status. If you wish the output to return to standby automatically after a set period of time,
select the option Monostable and set this time in the option Monostable Time ON next to it.
 Monostable Time ON: enter a value in seconds (1 to 86400 in 1 second steps) to indicate the time for which the output,
if monostable, remains active before returning to standby.

Input
When a T1, T2, T3, T4, T5 or T6 terminal is configured as an input, it can be programmed as Normally Open or Normally
Closed (see Polarity). The input is polled at least every 30 ms and, if its state remains stable for more than 300 ms, Input 1
Event is generated (for terminal T1).
The following options are available when programming the inputs:
 Panel Interconnection Present: if enabled, deactivation of the input generates the Panel Interconnection Fault
event and activating the input generates the Panel Interconnection Restore event.
 Dialer Block: if enabled, activating the input blocks the communicator and deletes the queue.
 Force Communication on Simulated Line: if enabled, activating the input switches from PSTN to cellular channel.

App Type Output
You can activate or deactivate the communicator’s outputs through the ConnectAlarm app.
Use this menu to set how the app activates or deactivates the outputs.
 Not Used: the app cannot activate or deactivate the output.
 Arm / Disarm: the ARM

and DISARM

buttons can be used to activate and deactivate the output.

The output is set as Bistable and you must connect it to a control panel’s input that arms the control panel when activated, and
disarms the control panel when on standby:
You need a communicator input to receive the control panel’s arming status: see Arm / Disarm. Status.
 Partial Arm 1: the button
output.

is used to activate the output. The button

will have the same label you set for the

The output is set as Monostable and you must connect it to a control panel’s input that performs a partial arming each time it is
activated.
You need a communicator input to receive the partial arming status: see Partial Arm / Dis. St 1.
 Partial Arm 2: similar to Partial Arm 1 but for partial arm 2.
 Partial Arm 3: similar to Partial Arm 1 but for partial arm 3.
 Partial Arm 4: similar to Partial Arm 1 but for partial arm 4.
 Arm Only: the ARM

button is used to activate the output.

The output is set as Monostable and you must connect it to a control panel’s input that arms the control panel each time it is
activated.
You need a communicator input to receive the control panel arming status: see Arm / Disarm. Status.
 Disarm Only: the DISARM

button is used to activate the output.

The output is set as Monostable and you must connect it to a control panel’s input that disarms the control panel each time it is
activated.
You need a communicator input to receive the control panel arming status: see Arm / Disarm. Status.
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 Automation Btn.: if there is not an input set as Automation input, with the same label as the output in question, the
app will have buttons to activate or deactivate the output similar to the following example, in the Output page.

Output 3
Element

Description
Output icon.

PGM 3

Output terminal.

Output 3 Output label you set in the Label option.
The output is set as Bistable and you must wire it to switch on or off the required appliance: the output activates when you click
the button

; the output goes on standby when you click the button

.

 You do not know the output status.
If you want to know the output status, set a terminal as Automation Input and assign to it the same label as the output you want
to control. In this case the app will have a button to activate or deactivate the output similar to the following example, in the Output
page.

Output 1

Element

Description
Output icon.

PGM 1

Output terminal.

Output 1 Output label and input label you set in the Label option.
Off

Output status.

The output activates when you click the button
changes to

: the button changes to

, the status changes to On, and the output icon

.

The output goes on standby when you click the button
output icon changes to

: the button changes to

, the status changes to Off, and the

.

App Type Input
You can display the communicator’s input status on the ConnectAlarm app.
This menu is for setting how the app shows the input state.
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 Not Used: the app do not show the input state.
 Arm / Disarm. Status: this input type can be used to display on the app the arming status of the control panel.
When the input is on standby, and there are not any partial arm/disarm status inputs active, the app shows the following information:

When the input is active, the app shows the following information:

Connect this input type to a control panel’s output that signals the arming status.
 Partial Arm / Dis. St 1: this input type can be used to display on the app the partial arming status of the control panel.
When the input is on standby, and there are not other partial arm/disarm status inputs, and arm/disarm status inputs active, the
app shows the following information:

When the input is active, the app shows information similar to the following example:

Perimeter
In the above example, Perimeter is the input label you set in the Label option.
Connect this input type to a control panel’s output that signals the partial arming status.





Partial Arm / Dis. St 2: similar to Partial Arm / Dis. St 1 but for the partial arming status 2
Partial Arm / Dis. St 3: similar to Partial Arm / Dis. St 1 but for the partial arming status 3.
Partial Arm / Dis. St 4: similar to Partial Arm / Dis. St 1 but for the partial arming status 4.
Alarm Status: this input type can be used to display the alarm status of the control panel.

When the input is on standby, and there are no tamper status and fault status inputs active, the app shows the following information:
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When the input is active, the app shows information similar to the following example:
PANEL ALARM

In the above example, PANEL ALARM is the input label you set in the Label option.
Connect this input type to a control panel’s output that signals the alarm status.
 Tamper Status: this input type can be used to display the tamper status of the control panel.
When the input is on standby, and there are no alarm status and fault status inputs active, the app shows the following information:

When the input is active, the app shows information similar to the following example:
PANEL TAMPER

In the above example, PANEL TAMPER is the input label you set in the Label option.
Connect this input type to a control panel’s output that signals the tamper status.
 Fault Status: this input type can be used to display on the app the fault status of the control panel.
When the input is on standby, and there are no alarm status and tamper status inputs active, the app shows the following information:

When the input is active, the app shows information similar to the following example:
PANEL FAULT

In the above example, PANEL FAULT is the input label you set in the Label option.
Connect this input type to a control panel’s output that signals the fault status.
 Automation input: This input can be used to control the status of an appliance.

60

Universal Cellular/Ethernet Communicators

firealarmresources.com

If there is no output set as Automation Btn., with the same label as the input in question, the app will show the input status, on
the Output page, as in the following example:

Input 4

Element

Description
Input icon when the input is in standby.

PGM 4

Input terminal.

Input 4

Input label you set in the Label option

Off

Input status when the input is in standby

When the input is active, the status is On and the input icon is

.

Wire this input type to control the status of the required appliance.
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Communicator
This page configures the events transmitted by the communicator.

Communicator Options
Call Options
 Call All Numbers: select this option to call all numbers set for a given event.
You can select: Voice Calls, CID: Over GSM, Voice Calls and CID: Over GSM and Disabled. If this option is not
selected, the communicator terminates the cycle of calls as soon one of them terminates successfully.
 Call Confirmation: select this option to have the dialer wait for the remote user to confirm reception of the voice message,
otherwise the dialer will try sending the voice message again; the remote user can confirm by pressing  on his phone
(for tone dialling phones only).

 While listing to a voice message, pressing  on the phone keypad blocks both the current call and any queued calls as well.
In some cases the dialer may bad interpret the response of answering machines, mobile service operator courtesy messages
and so on, so we recommend leaving Call Confirmation enabled.
 Repeat Call: this option is used to enter the number of attempts to be performed (up to a maximum of 8) if the call is not
successful.
 Repetitions: enter the number of times the voice message is to be repeated (up to 8) when the called number answers.
 Voice message Header: select the voice message the communicator will play at the begin of each voice call.
Periodic SMS and Voice
 Periodic SMS/Call Send Interval: set the interval (Days and Hours) between two Periodic Call/SMS events.
Range: 0 to 365 days and 0 to 23 hours.
 Periodic SMS /Call First Send: select the date and time for sending the first Periodic Call/SMS event.
The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.
The Now button sets the PC's current time.

 In order to ensure conformity with EN 50136-2, the Periodic SMS/Call First Send time must be set to 1 day, and this
function may not be modified. Factory setting: 1 day.
To set the options for Periodic SMS/Call First Send, enter the SIM Phone Number and enable Automatic Clock
Adjust options in the Options page.
 Ring only for periodic event: with this option enabled, the system sends a 5 s ring tone instead of a periodic voice
message.
Periodic Call
 Periodic Test Transmission Interval: set the interval (Days and Hours) between two Periodic Test Transmissions
events. Range: 0 to 365 days and 0 to 23 hours.
 Periodic Test Transmission First Send: set the date and time of the first Periodic Test Transmission event.
The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.
The Now button sets the PC's current time.
SIA
 Date/Time on SIA packet: if enabled, the SIA packet will include the date and time.
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Inputs and Events
SMS / Push Notifications
This table specifies, for each event handled by the communicator, the SMS message to send to the numbers specified in the column
SMS Tel. Number, and to the app.
 Event: this column lists the events for which a SMS message is to be sent: refer to “Internal events” on page 28 for a
description of the events.
 Telephone Numbers: select the numbers to which an SMS is to be sent.
Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [–] to collapse the column: a list of selected telephone numbers will be shown.
 Push Notification: if enabled, the event sends to the app the message set in the SMS / Push Notification Text option.
 SMS / Push Notification Text: enter the text to be sent when the event occurs (up to 70 characters).
Voice Calls
This table specifies, for each event handled by the communicator, the voice messages to send to the numbers specified in the column Telephone Numbers.
 Telephone Numbers: select the numbers to which the event is to send a voice message.
Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [–] to collapse the column: a list of selected telephone numbers will be shown.
 Voice Messages: select the voice messages to be sent in response to the event: you can select up to three voice messages
per event (First Message, Second Message and Third Message); click on [...] to browse the list of messages; you can
select a pre-recorded message (see Voice Messages) or record a new one, or open a .wav file on the PC. The Header
column shows the message selected in Call Options > Voice Message Header.
Central Station Calls
This table specifies, for each event handled by the communicator, the digital messages to send to the numbers specified in the
column Telephone Numbers.
The communicator sends the Contact ID messages to the app when Customer code and Contact ID Identifier options are
different from zero, and Event Enabled option is different from Disabled.
 Event: this column lists the events for which a digital message is to be sent.
 Telephone Numbers: select the numbers to which the event is to send the digital message, when you have selected
Channel Type, CID: Over GSM.
Double click on [+] to expand the column: a table will be shown to specifies which numbers in the Phonebook are to be
used for sending digital messages (up to 8 numbers can be set).
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [–] to collapse the column: a list of selected telephone numbers will be shown.

 When you select Channel Type, CID/SIA: over Data Network, the events are transmitted to the IP receivers indicated
in the IP Receivers page.
 Customer code: enter the user code (4 hex characters).

 You can set a different Customer code for each Input Event, or a single Customer code for all other events.
DO NOT use the character “A” for Contact ID.
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 Contact ID Identifier: enter the Contact ID the communicator is to send for the event.

 The communicator also sends the qualifier 1 when the event occurs and the qualifier 3 when it terminates, as required by the
Contact ID protocol.

 The communicator also sends the number of input that has triggered the event (the zone number): 01 for input 1, 02 for input
2, 03 for input 3, 04 for input 4, 05 for input 5, 06 for input 6.
 Event SIA Identifier: enter the SIA code the communicator is to send when the event OCCURS.
 Restore SIA Identifier: enter the SIA code the communicator is to send when the event TERMINATES.
 Event Enabled: select Disabled to NOT send the event; select Send Activation to send ONLY the event's occurrence;
select Send Restoral to send ONLY the event's restoral; select Send Activation and Restoral to send both.
 Channel Type: select CID: Over GSM to send the event with the Contact ID protocol using a voice call on the cellular
channel; select CID/SIA: over Data Network to send the event with the Contact ID or SIA protocol on the cellular or
Ethernet channel (the protocol will be the one selected in the Communication Protocol option in the Options page).

 Contact ID messages may NOT be understood by the PSTN receivers due to distortion on the cellular network. It is
recommended to select CID/SIA: over Data Network instead.

CID/SIA Converter
If the communicator detects that the panel connected to the LI terminals is dialing a number from the Phonebook with the option
CID/SIA Event Conversion enabled, it converts the panel's Contact ID or SIA message into a voice or SMS message,
as indicated in this page.
The following tables show the way the CID/SIA Converter subgroup options concur in building of SMS and voice message.
1

Labels/
Messages

SMS / Push Notifications

2

SMS Header
for event

Activation or
Advanced > Activation or
Restore or
Advanced > Restore

3 7

SMS Header Partitions
for area
> Label

Users >
Label or
Zones >
Label

SMS Header for
user or SMS
Header for zone

16

7

16

7

16

Alarm

Partition

Warehouse

Zone

Entrance

DSC

Alarm end

Partition

Warehouse

Zone

Entrance

DSC

Arming

Partition

Warehouse

User

Brown

DSC

Disarming

Partition

Warehouse

User

Brown

DSC
4

Labels/Messages (5)

Table 14 – Conversion of Contact ID and SIA message to SMS: 1) option subgroup; 2) option; 3) SMS maximum length;
4) examples; 5) Contact ID only.
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1

Communicator
Options

Voice Calls

2

Voice Message
Header

Activation or
Advanced > Activation or
Restore or
Advanced > Restore

3 6 seconds

4

Labels/Messages (5)

Partitions > Voice Message

Users > Voice Message or
Zones > Voice Message

6 seconds

6 seconds

6 seconds

DSC

Alarm

Warehouse Partition

Entrance Zone

DSC

Alarm end

Warehouse Partition

Entrance Zone

DSC

Arming

Warehouse Partition

Brown User

DSC

Disarming

Warehouse Partition

Brown User

Table 15 – Conversion of Contact ID and SIA message to voice message: 1) option subgroup; 2) option; 3) voice message
maximum length; 4) examples; 5) Contact ID only.
Two setup modes are possible:
 the base setup allows you to convert digital messages to voice and/or SMS messages by setting up a small number of
options: messages will signal event activation and restore only.
 the advanced setup allows you to convert digital message details like event description and, for Contact ID protocol, the
involved partition, zone and user.
SMS / Push Notifications and Voice Calls
Base setup allows you to define general messages for Alarms, Tampers, Openings and Closings and System Troubles
event categories, as explained in the following paragraphs.
 Category: shows the event categories. Settings made for a category will be automatically copied into all the category
events, in the Advanced group.

 If different settings for each event are required, the following options must be empty and the required settings shall be made
in the Advanced group.
 Telephone Numbers: select the numbers to which the event is to send a message.
Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [–] to collapse the column: a list of selected telephone numbers will be shown.
 Push Notification: if enabled, the event send to the app the text message set in the Activation and Restore options.
Header: shows voice message selected in Communicator Options > Voice Message Header. The communicator will play
this message at the begin of each voice call. It is generally used to identify the system.

 This option is available in Voice Calls group only.
 Activation: setup the message the communicator sends when an event in that category occurs.
 Restore: setup the message the communicator sends when an event in that category ends.
Advanced
This option group allows for the setup of different option for each event, over those explained in the base setup, as explained in the
following paragraphs.
 Event: shows the events the communicator can convert.
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 Contact ID Identifier: shows the default Contact ID code for the event. This option can not be modified.

 This option is considered only if Contact ID has been selected as Communication Protocol in the Options page.
 If Contact ID codes differ from defaults have to be converted, you can set up to 10 custom event codes for events in the
Custom group you can find at the end of event group list.
 Event SIA Identifier: enter the SIA event code to be converted for the event verification.
 Restore SIA Identifier: enter the SIA event code to be converted for the event restore.

 The Event SIA Identifier and Restore SIA Identifier options have default values that have to be verified. Enter 00 if
conversion is not required.

 The Event

SIA Identifier and Restore SIA Identifier option is considered only if SIA has been selected as

Communication Protocol in the Options page.
Labels/Messages
The Contact ID protocol sends information on users, zones and partitions of the events.
Options in this group allow for assignment to each user, zone and partition number a SMS and/or voice message used for the message building during the conversion.

 Up to 128 user / zone / partition numbers in total can be converted.
 SIA protocol also sends information on users, zones and partitions but they are NOT converted by this communicator. If SIA
is selected as Communication Protocol in the Options group, you can setup the SMS Header for event option ONLY.
 SMS Header for event: enter the text you want at the begin of each SMS. Generally it is used to identify the system.
Valid entries: up to 7 characters.
Default: empty.
 SMS Header for user: enter the text you want before the message set for user identification.
Valid entries: up to 7 characters.
Default: a comma.
 SMS Header for zone: enter the text you want before the message set for zone identification.
Valid entries: up to 7 characters.
Default: a comma.
 SMS Header for area: enter the text you want before the message set for partition identification.
Valid entries: up to 7 characters.
Default: a comma.
Users / Zones / Partitions
 Send only if user is defined / Send only if zone is defined / Send only if area is defined: if disabled (default), a
digital message is converted even if its user / zone / partition number is NOT present into the conversion tables. In this case
the user / zone / partition information will be not present. If enabled, digital messages without user / zone / partition
information in the conversion tables will be NOT converted.
 Add: select this button to add a user / zone / partition number to convert.
 User Number / Zone Number / Partition Number: enter the number to convert.
Valid entries: from 0 to 999; 65535 to disable.
Default: 65535.
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 Label: enter a text useful for user / zone / partition identification.
Valid entries: up to 16 characters.
Default: empty.
 Voice Message: select a voice message useful for user / zone / partition identification.
Default: (none).


: select this button to delete relative row.
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IP Receivers
This page sets the options relating to the communicator's connection with compatible Sur-Gard System IP receivers.

 Given possible delays in transmission on the cellular data network, depending on the activity of the network operator,
we recommend programming as high as possible the number of call attempts on the panel, and also setting a backup phone
number which will send the alarms to a PSTN receiver.

 The communicator does NOT support the shutdown command by Sur-Gard receivers.
Receiver Options
 Receiver Channel Priority: select the channel, and the priority, the communicator uses to communicate with the
receivers. Factory setting: Cellular Only.
 Fibro Account # (Cellular): enter the account number for the Fibro protocol over the cellular channel: when transmitting
events to IP receivers, the Contact ID and SIA are wrapped in the Fibro protocol and this requires its own account number to
identify the account which is sending the events.
Contact your central station for details. Factory setting: 0000FFFFFF.

 You must assign a different account number to each communicator which transmits events to a given receiver.
 Fibro Account # (Ethernet): similar to Fibro Account # (Cellular) but for the Ethernet channel.
Contact your central station for details. Factory setting: 0000FFFFFF.
 DNIS: the communicator transmits the DNIS code inside the Fibro packet to enable the receiver to identify the device (hex
numbers from 00000 to FFFFF).
 Encryption Enabled: if enabled the communicator encrypts all communications with the IP receivers to increase the
security of its data transmissions.
 Hold ACK in memory timeout: sets how long an IP receiver ACK (acknowledge) is kept in memory. Within this period of
time, if the communicator detects that the panel is attempting again to send a message to the IP receiver and the latter
acknowledges it (ACK), the communicator confirms reception directly to the panel with a kiss-off signal, without sending the
message again to the IP receiver. If set to 0 (factory setting) ACK's are not held in memory. It is worth setting a value greater
than 0 when the panel attempts to transmit each call only once and does not manage to receive the ACK from the IP receiver
on time. Range: 0 to 15 minutes. Factory setting: 0.
Receiver 1
 Functionality mode: select Primary (receiver 1 is enabled) or Not Used (receiver 1 is disabled, the programming of
receiver 2 will be ignored, CID/SIA event transmission is disabled).
 IP Address: enter the receiver's IP address. The address can be entered in the numeric format (e.g. 192.168.0.101) or host
and domain format (Fully Qualified Domain Name, e.g., host_name.domain_name.com).
 Remote Port: enter the UDP port receiver 1 is listening to. Range: 1 to 65535. Factory setting: 3061.
 Receiver 1 Local Port: for each receiver, the communicator uses a different UDP port. Range: 0 to 65535. If the local port is
0, the communicator uses a random port number in the range 1-65535. Factory setting: 3060 (3065 for receiver 2).
 APN (Cellular): enter the Access Point name. This is generally supplied by the cellular network operator.

 Make sure the APN is correct for access to the cellular data network, otherwise certain functions may be limited (contact your
phone operator for details).
 APN User Name (Cellular): some operators require communication authentication; enter the user name in this field if
necessary.
 APN Password (Cellular): some operators require communication authentication; enter the password in this field if
necessary.
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 Supervision Enabled: if enabled, the communicator supervises communications with the receiver.

 The supervision messages are not sent during voice calls (on cellular channel).
 Supervision Time (Cellular): set the supervision time for the cellular channel. Range: 60 to 65535 s, in 1 s steps.

 In order to ensure conformity with EN 50136-2 supervision must be enabled and the Supervision Time must be no more than
3 minutes.
 Supervision Time (Ethernet): similar to Supervision Time (Cellular) but for the Ethernet channel.
Receiver 2
The options for Receiver 2 are the same as those for Receiver 1, except for the differences described below.

 If Functionality mode for receiver 1 is Not Used, you can NOT set the options for receiver 2: transmission of CID/SIA
events to the central station is disabled.
 Functionality mode: if Functionality mode for receiver 1 is Primary, receiver 2 may be:
 Not Used, receiver 2 is disabled, the communicator sends the CID/SIA to receiver 1 only (this mode is called “single mode”);
 Backup, the communicator sends the CID/SIA messages to receiver 1 and, should it not be operational or reachable, sends
them to receiver 2 (this mode is called “Main + Backup”);
 Redundant, the communicator sends the CID/SIA to both receiver 1 and receiver 2 simultaneously and sends the ACK
(confirmation of reception) to the panel only if both receivers confirm reception (this mode is called “Redundant”).
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Voice Messages
The Voice Messages page enables you to record and play back voice messages: refer to “Inputs and Events” on page 63, for
how to associate messages to events.
The voice messages can be recorded with a microphone connected to the PC, you can load pre-recorded messages from the PC
(hard disk, LAN, USB key, etc.) or you can import voice messages from another communicator, as described in paragraph “Programming/Audio Import/Export” on page 44”.

 The Console can import all type of audio files in the WAVE format (.WAV).
Play button: press this button to play back a voice message.
Record button: press this button to start recording a new voice message.
Stop button: press this button to stop playing back or recording the current voice message.
Pause button: press this button to pause playing back or recording the current voice message.
Clear button: press this button to delete a voice message saved in the communicator.
Open button: press this button to load a voice message from a PC resource (hard disk, LAN, etc.).
Save button: press this button to save a voice message to a PC resource (hard disk, LAN, etc.).

 While a message is being recorded, a progress bar indicates the duration.
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PSTN/PTM
This page relates to the PSTN line and the PTM function (Panel Transmission Monitoring). The PTM function enables the communicator to forward calls on the cellular channel if communications between the panel and the receiver on the PSTN line fail.

 After 5 minutes of use of the cellular channel, the communicator will start using the PSTN line again for forwarding panel calls.
The PTM function considers communication to have failed when:
 it does not detect dialing, if the Check Dialing option is enabled (it checks that a number is actually dialled);
 it does not detect the kiss-off (the signal sent from the receiver when a communication terminates successfully).
If the PTM All Numbers option is enabled, PTM is executed when the panel dials any number, otherwise it only monitors the
dialling of numbers which have the PTM option enabled in the Phonebook.
Calls are forwarded on the cellular channel when the PTM Max Errors Before Takeover setting is reached.

Primary Path
 Primary Communication Path: if you set PSTN, the communicator uses the PSTN line as its primary channel and
switches to the cellular and Ethernet channels only when the PSTN fails or when the PTM function trips; if you select
Cellular and Ethernet, the communicator uses ONLY the cellular and Ethernet channels.

Timeouts
 LE Failure Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on the LE terminals can be absent
before the PSTN Fault event occurs.

 If any phone devices are connected to the LI terminals, this time may increase up to a maximum of approx. 60 s.
 LE Restore Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on the LE terminals must be
present before the PSTN Fault Restore event occurs.

 To ensure conformity with EN 50136-2, the LE Restore Timeout (sec) option should not be modified. Factory setting: 10 s.
PTM
 PTM Max Errors Before Takeover: the communicator switches to cellular channel when it detects this number of failed
attempts. Range: 1 to 4, 0 disables the option. Factory setting: 0 (disabled).
 PTM All Numbers: if enabled, PTM is executed when the panel dials any number, otherwise it only monitors the dialling
of numbers which have the PTM option enabled in the Phonebook.

 The PTM Max Errors Before Takeover option must be non-zero before you can modify the PTM All Numbers setting.
 Check Dialing: if enabled, the communicator considers a off-hook followed by a on-hook without any number being dialled
by the device connected to the LI terminals to be a failure. Factory setting: disabled.

 The PTM Max Errors Before Takeover option must be non-zero before you can modify the Check Dialing option.
Generic
 Dialing Prefix: when the communicator detects a number being dialled with the prefix in this setting, it sends the call to the
cellular channel, to the phone number without the digits indicated in this option, even if the PSTN in available. Factory setting:
9999.
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Event Log
The Event Log page displays the events logged by the communicator.
The communicator can save up to 2048 events: when the buffer is full, each new event overwrites the oldest, which is thus lost.
Each event indicates the date and time at which it occurred.

Symbols on the Event Buffer bar
Click on this icon to load the new events the next time a Global Upload or Communicate Tags is run.
Click on this icon to cancel the selection of events in the event buffer.
Click on this icon to open a window for saving an .XML file of the events loaded in the Event Log page.

 The .XML file can be viewed with Excel or a compatible application.
Click on this icon to display the events in relation to the criteria indicated in the Events In and With Text options.
 Events In: select the events you wish to view: All Events, Today, Last 7 Days, Last 14 Days, Last 30 Days, Last
Year or Custom.
Select Custom to set a specific period of time.
 With Text: only events containing the specified text will display.
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Firmware Update
!

Updating the firmware from 1.00 and 1.10 revisions to 1.20 revision and above, results in CID/SIA conversion settings
to be lost.

 Only the level 4 installer, when enabled by the installer, can run firmware updates.
The Firmware Update page updates the communicator's firmware, both locally (PC-Link or USB) and remotely (cellular data
network).
Click on Select Firmware File to select the update file.
If the firmware update does not terminate successfully, the communicator will continue using the old version.
The name of the firmware file has the format FWxxyyzz.bin where:





FW identifies the file as firmware;
xx is the higher revision number;
yy is the lower revision number;
zz is the test revision number;

.bin is the extension for a binary file.
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Status
The Status page gives a range of information about the communicator, as indicated below.
When you select the Status page, the console automatically displays the Communicate Tags window to establish communications with the communicator; once it is, the Status page updates every 5 seconds

Device Information
The Device Details box shows information which may be requested by technical assistance.
The Network Status box shows information relating to the cellular network, as given below.
GSM Provider Name: indicates the name of the mobile phone operator.
GSM Signal Strength: gives the strength of the cellular signal.
Cellular: the type of network.
Best Operator: when no SIM is in the communicator, it shows the mobile operator with the best signal strength.
Last Credit Received: shows the SIM's credit updated to the last request made with the Request for PayAsYouGo
Balance button or as programmed in the Pay As You Go Balance section of Options page.
 Last Credit Date/Time: shows the date and time of the last credit update.
 Request for PayAsYouGo Balance: press this button to display the residual credit of the communicator's SIM card.







 This function is only available with the local connection (PC-LINK or USB) and if the Pay As You Go Balance options in the
Options page have been set properly.

GSM
LED

Normal operation

Malfunction

GSM ready

Green: the cellular network is available and the
communicator is operating.

Red: the communicator is not yet ready.

Radio ON

Green: the radio module is on.

Red: the radio module is off.

SIM OK

Green: the SIM is properly functioning.

Red: there is a problem with the SIM card: SIM not
present, SIM expired, PIN enabled on SIM.

Carrier OK

Green: the operator is connected.

Red: the operator has not been connected.

Signal OK

Green: the signal strength is above the required
minimum.

Red: signal too low or no signal.

Main board
LED

Normal operation

Malfunction

Power OK

Green: main power (+V terminal) is above the
minimum threshold.

Red: main power (+V terminal) is less than 10 V.

Battery OK

Green: the communicator's battery (if any) is
charged.

Red: the battery voltage is less than 3.4 V.

PSTN OK

Green: the PSTN line (connected to the
communicator's LE terminals) is available.

Red: the voltage on the LE terminals is less than
2.5 V.

No Jamming

Green: no jamming.

Red: the communicator's function is being jammed
(sabotage).

Antenna OK

Green: the antenna ANTLTE-02 is connected and Red: the antenna ANTLTE-02 is connected but
working properly.
NOT working OK (wire cut).
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Call






Incoming Call: orange—the communicator is receiving a call.
Call In Progress: green—the communicator is engaged with a call.
Outgoing Call: orange—the communicator is making a call.
Radio Initializing: green—the radio is initialising.
Passthrough: green—the communicator is in pass-through mode.

App Server
 Cellular Status: like Cellular Status of Receiver 1 but for connection status with the app server, over the cellular
channel.
 Ethernet Status: like Cellular Status of Receiver 1 but for connection status with the app server, over the Ethernet
channel.

Receiver 1
Cellular Status: this LED shows the connection status with receiver 1, over the cellular channel, as given below.
grey: the options for receiver 1 have NOT been programmed;
orange: receiver 1 is connected but NOT initialised;
red: the options for receiver 1 have been programmed but the receiver is not initialised, has disconnected due to a problem,
is unable to connect or initialisation has failed;
 green: receiver 1 is initialised and connected.
 Ethernet Status: like Cellular Status but for connection status with receiver 1, over the Ethernet channel.






Receiver 2
 Like Receiver 1 but for receiver 2.

Inputs
Shows input status: grey, standby input; green, active input.

Outputs
Shows output status: grey, standby output; green, active output.
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Downloading and Uploading
Once the options have been set up, they must be downloaded to the associated communicator, as follows.
To perform the downloading and uploading you must connect the communicator to the PC on which the console is installed.

 It is also possible to download and upload options using a USB key as described in “Operations with the USB key” on page 82.
Connecting the communicator to the PC
You can connect the communicator to a PC:
 locally, via the PC-LINK serial port;
 locally, via the USB serial port;
 locally, via LAN net (request the Ethernet interface);
 remotely, via the Internet, via cellular or Ethernet channel (the Ethernet channel requests the Ethernet interface);
 Connecting via PC-LINK serial port
1. Connect the communicator PC-LINK serial port to a free RS232 serial port on the PC using the PC-LINK cable (accessory
item), as shown on Figure 8.

B

A

1

4

5
3
2

Figure 8 – PC-LINK cable connection: A) RS-232 female connector, solder side B) insert the PC-Link cable properly.
2. Select the PC serial port used for connection with the communicator, as follows:
– select Modem Manager Configuration from the Tools menu;
– select the PCLINK - COM1 connection;
– select the PC serial port where the communicator is connected to, from the Port menu;
– click OK.
 Connecting via USB serial port

 Be sure that the PST jumper is NOT present otherwise communicator programming and status view are NOT possible.
1.
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Connect the communicator USB serial port (17 on Figure 2) to a free USB serial port on the PC using the USB-5M cable
(optional) or an equivalent USB cable (USB A-A cable).
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2.

Select the PC serial port used for connection with the communicator, as follows:
– select Modem Manager Configuration from the Tools menu;
– select the PCLINK - COM1 connection;
– select the PC serial port where the communicator is connected to, from the Port menu;
– click OK.
 Connection via Internet (cellular or Ethernet)
To set up connection via Internet (cellular or Ethernet), do the as follow.

 If a Ethernet connection is available, the cellular channel is used just to start the connection, after that the communication
continues on the Ethernet channel.
1.
2.
3.
4.
5.

Select the customer account properties (right click on the customer account’s name, then Properties).
On the left of the Account Name window, select the communicator from Panels/Modules branch.
If you have not already done, enter the communicator’s Device ID1, and set the EN50136 option as required.
Select Cellular (IP remote) from the Connection Type menu then click Add.
Select Cellular (IP remote)2 from the communicator branch then enter the telephone number for the communicator in the
Panel Phone Number field, select required Connection Timeout3, and click Save.

6.
7.

Open the customer account and select Global Download
, Global Upload
, or Communicate Tags
.
Select Cellular (IP remote) from the Connection Type menu, and enter the Access Code for the indicated User
Type.

 You can disable the option Automatically Hangup when Finished to keep the connection live until you click the
button under the Disconnect When Complete

Disconnect Immediately

menu.

8.
9.

Click OK: the SMS Message Generator window displays.
Type the public IP address of the router to which the PC is connected in the option Public IP Address and the port to
access the console (DLS Port): ask the network administrator or see the router’s instructions.
10. If this is the first installation, press APN Settings and set the APN Name, User Name, and Password for mobile data
services (ask the operator of the mobile data service).

 Make sure to type the correct APN for WAP access - otherwise some functions may be limited.
11. Prepare an SMS message as outlined in the SMS Message Generator window or scan the QR code shown in the same
window, then click OK: the console waits for the incoming connection.
12. Send the SMS to the communicator number before the Connection Timeout time expires.
After receiving the SMS message, if correct, the communicator opens a remote connection via cellular or Ethernet channel with the
console: at this point, options can be downloaded or uploaded, as outlined in the section “How to download and upload the options”
on page 78, and the communicator can be managed through the Status page.

 On the router connected to the console PC, the forwarding port from the console external port to port 51004 (internal console
port, CANNOT be changed) must be configured: request router instructions from the network administrator.
 Connection via LAN (IP)

1.
2.
3.

Enter the communicator's serial number from the communicator’s electronic board: you can find the same option in
the Network Settings option group.
When Save is pressed Cellular (IP remote) is replaced by the number entered in Panel Phone Number.
Connection Timeout is the time the communicator waits for a configuration SMS.
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To set up connection via LAN (IP), proceed as described below.
1.
2.
3.
4.
5.
6.
7.
8.
9.

Connect the communicator’s Ethernet port (31 in Figure 1) to the LAN network where the PC with the console is connected,
or directly to the PC with the console.
Select the customer account properties (right click on the customer account’s name, then Properties).
On the left of the Account Name window, select the communicator from Panels/Modules branch.
Select IP from the Connection Type menu then click Add.
On the left of the Account Name window, select IP in the communicator branch.
Click AUTO Discovery: the table in the IP Detected section will show the communicators found on the LAN.
Select the required communicator from the IP Detected table: the IP Address of the selected communicator is copied in
the IP filed.
Align the option Port with the option Ethernet Local Incoming Port in Network Settings > DLS, if you changed the
factory setting 3062.
Click Save.

At this point it is possible to download and upload options as outlined in the section “How to download and upload the options” on
page 78, and manage the communicator via the Status page.
 Notes for Internet connection (cellular or Ethernet)
To download and upload options via Internet (cellular or Ethernet):






the PC on which the console is installed must be connected to the Internet;
the PC must have a public IP address and a public port for incoming connections to the console;
the firewall and the router must allow the PC to connect the public port to port 51004 of the console;
the communicator’s options must be set as described in “Network Settings” on page 52;
a SIM card must be inserted in the communicator and the credit on the SIM must be sufficient for cellular data services.

How to download and upload the options
Once you have set up the connection, you can download and upload the options as follow.

 Downloading is the operation that transfers data from PC to communicator. Uploading is the operation that transfers data from
communicator to PC.
1.

Either select the options to download and upload by enabling the relative downloading or uploading tabs
next step to download or upload ALL the options (global downloading or uploading):

 the tag (

or jump to the

) means that the relative option neither will be uploaded nor downloaded;

 the blue tag (

) means that the relative option will be uploaded;

 the red tag (

) means that the relative option will be downloaded.

 Modified options are automatically marked for uploading.
You can enable all the group options to be uploaded or downloaded by clicking on the
You can clear all the group option tags by clicking on the icon

on the group toolbar.

You can clear option tags of all groups by clicking on the icon

on the main toolbar.
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2.

Either click on the icon
to start the downloading and uploading of the selected options or click on the
to download or upload ALL the options.

or

icon

 Global downloading does not download voice messages and the voice message labels. Global uploading does not upload
voice messages, the voice message labels and event log1.
The application shows the Communicate Tags, Global Download or Global Upload window.
3.
4.

5.

Select the Connection Type.
Ensure the Access Code is the same as the User Code, Installer Code or Level 4 Installer Code set in the Options
group (factory setting, respectively 000000, 111111, and 222222) and the Device ID is correct (see “Network Settings” on
page 52).
Click OK.

1.

The event Log can be uploaded from the Event Log page.
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APPENDIX
Conformity with EN 50136-2:2013
To be compliant with EN50136-2:2013, the communicator must be configured and connected to a burglary alarm panel in one of
the two following ways (A and B) only:
A) PSTN connection (the panel must monitor the receiver's response directly via PSTN)
PSTN: The communicator's LI terminals are connected to the panel's external phone line terminals.
Terminal T4, configured as the Tampers output, is connected to a panel input (models with plastic housing only).
Terminal T5, configured as the GSM Fault output, is connected a the panel input.
Terminal T3 configured as Panel Interconnection Present input, is connected to the panel signal, to report that the panel
is present, or phone line present signal.
 Terminal T6, configured as IP Receiver Fail, is connected to the panel's jamming input.






 In the communicator's programming page IP Receivers—specify an IP receiver.
B) no PSTN
 Terminal T4, configured as the Tampers plus Jamming Detect output, is connected a the panel input (models with plastic
housing only).
 Terminal T5, configured as the GSM Fault output, is connected a the panel input.
 Terminal T1, configured as the alarm/tamper input, is connected to the panel's intrusion alarm/tamper output.

 Input 1 Event is used to send the intrusion alarm code.
 Terminal T2, configured as an input, is connected to the panel's fault output.

 Input 2 Event is used to send the fault code.
 Terminal T6, configured as IP Receiver Fail output, is connected a the panel's input.
 Terminal T3 configured as Panel Interconnection Present input, is connected to the panel signal, to report that the panel
is present.
 The communicator's earth terminal must be connected to a panel input, to detect the connection between the panel and the
communicator.

 In the communicator page Central Station Calls, for the two events Input 1 Event and Input 2 Event, set a Customer
Code and set Channel Type to CID/SIA: over Data Network. In the IP Receivers page, specify an IP receiver.
See the following tables.
Communicator

Panel



LI

LE

T1: PSTN Fault output
T2: No Cellular Network output
Table 16 – Connection scheme A: simulated PSTN.
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Factory setting

Communicator
T3: Panel Interconnection Present input
T4: Tampers output
T5: GSM Fault output
T6: IP Receiver Fail output

Panel






LE detection output









Alarm/Tamper output

Communicator tamper input
Cellular fault input
IP receiver communications failure input

Table 16 – Connection scheme A: simulated PSTN.

Communicator
T1: Alarm/Tamper input

Factory setting

T2: Fault input
T3: Panel Interconnection Present input
T4: Tampers plus Jamming Detect output
T5: GSM Fault output
T6: IP Receiver Fail output
Earth terminal

Panel

Fault output
Interconnection present output
Communicator tamper input
Cellular fault input
IP receiver communications failure input
Earth terminal

Table 17 – Connection scheme B: without simulated PSTN.

 The following must be configured: an event for sending the alarm/tamper Contact ID, in case of activation of input 1, and an
event for sending the fault Contact ID in case of activation of input 2.
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Operations with the USB key

 The USB can ONLY be used if the communicator is in USB Host mode (see “Description of jumpers” on page 11) and the
EN50136 option is disabled (see “Options” on page 49).
The USB key allows you to:
 update the communicator's firmware;
 export/import the communicator's settings;
 export/import the communicator's voice messages;
 export the communicator's event buffer;
 Load custom defaults into the communicator.
When a USB key is inserted into the communicator's USB port, the folder structure in figure 9 is created (marked with the symbol

1 B_FW

4 FWxxyyzz.bin

1 B_DEF

4 defaults.bin

).

4 eprog001.bin
1 B_PROG

2 export.txt
1 EXPORT

4 eprog002.bin

2 import.txt
4 eprognnn.bin
1 SSSSSSSS
4 eprog001.bin
1 IMPORT

4 eprog002.bin
4 eprognnn.bin
4 eaud001.bin

1 B_AUDIO

2 export.txt
1 EXPORT

4 eaud002.bin

2 import.txt
4 eaudnnn.bin
1 SSSSSSSS
4 eaud001.bin
1 IMPORT

4 eaud002.bin
4 eaudnnn.bin

1 B_LOG

2 log.txt
1 SSSSSSSS

4 elog001.csv
4 elog002.csv
4 elognnn.csv

Figure 9 – File structure of a USB key used with the communicator.
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SSSSSSSS represents the communicator's serial number (8 hex digits), so that a single USB key can hold data for several different
communicators: each communicator will read/write to its own folder.
When a USB key is inserted into the communicator, the following procedure is executed:
1.
2.
3.
4.
5.
6.
7.

Firmware update, if a valid firmware is in folder B_FW;
Communicator set with custom defaults, if defaults.bin is in the folder B_DEF (see “Loading custom defaults” on page 83 for
more details).
Communicator settings file export, if the file export.txt is in folder B_PROG;
Communicator settings file import, if the file import.txt is in folder B_PROG;
Communicator voice message export, if the file export.txt is in folder B_AUDIO;
Communicator voice message import, if the file import.txt is in folder B_AUDIO;
Communicator event buffer export, if the file log.txt is in folder B_LOG;

Firmware Update
This operation updates the communicator's firmware from a USB key.
1.

Download the firmware from the site www.dsc.com.

The name of the firmware file has the format FWxxyyzz.bin where:






FW identifies the file as firmware;
xx is the higher revision number;
yy is the lower revision number;
zz is the test revision number;
.bin is the extension for a binary file.

 DO NOT rename the firmware file, otherwise the communicator will not recognise it.
2.
3.

Copy the firmware into folder B_FW on the USB key.
Insert the key into the communicator's USB port.

If the communicator finds an invalid firmware in folder B_FW, the ACT LED will flash slowly and the event Firmware Upgrade
failed - System is logged to the event buffer.
If the communicator finds a valid firmware in folder B_FW, which is also different from its current firmware, it will install it.

 If more than one firmware file is in folder B_FW, the communicator will install the one with the highest revision number.
If folder B_FW contains a firmware which is less recent than the current one installed on the communicator, it is installed
anyway: firmware updates allow you to install a more recent firmware or restore an older one than currently installed on the
communicator.
At the end of the process the communicator reboots and logs the event FW upgrade done - System.
in the event buffer.

Loading custom defaults
To load custom defaults from a USB key, complete the following steps.
1.
2.

Create the folder B_DEF on the USB key, if it is not already there.
Copy the settings file to the B_DEF folder: the settings file may be created as described in the export procedure, or on the
Console.

 The export procure and the console generate the file eprognnn.bin, where nnn is an index from 001 to 999. You must rename
the file to defaults.bin before coping it in the B_DEF folder.
3.
4.

Delete the B_PROG/import.txt file, if present.
Insert the USB key into the USB port of the communicator.
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5.
6.

Close the PST and USB jumpers.
Perform the factory setting restore as indicated in “Restore Factory Settings” on page 45.

The communicator is programmed as specified in the defaults.bin file; it then reboot.

 Do not remove the USB key until the communicator reboots.
After the communicator reboots, you can set the PST and USB jumpers as required.

 You can import the default settings in any communicator because the defaults.bin file is independent form the communicator
that has generated it.

Exporting settings
This operation exports the communicator's settings to a USB key.
1.
2.
3.

Create the folder B_PROG on the USB key, if it is not already there.
Create a new text file in folder B_PROG and call it export.txt.
Insert the USB key into the communicator's USB port.

The communicator will export its settings to B_PROG\SSSSSSSS\EXPORT\eprognnn.bin, where:





SSSSSSSS is the communicator's serial number;
eprog is the prefix for a communicator settings file;
nnn is an index from 001 to 999;
.bin is the extension for a binary file.

In the EXPORT folder, the communicator will search for setting file with the highest index and create a setting file with that index
incremented.
If the EXPORT folder already has a settings file with index 999, exporting is not possible: the ACT LED will flash slowly and the
event USB Programming Export Failed - System is logged to the event buffer.

Importing settings
This procedure imports settings from a USB key.
1.
2.
3.
4.
5.
6.

Create the folder B_PROG on the USB key, if it is not already there.
Create a new text file in folder B_PROG and call it import.txt.
Create the folder SSSSSSSS in B_PROG, where SSSSSSSS is the serial number of the communicator to which you wish to
import the settings.
Create the folder IMPORT in the SSSSSSSS folder.
Copy the settings file to the IMPORT folder: the settings file may be created as described in the export procedure, or on the
Console.
Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will delete the file import.txt and will be programmed as specified in the imported settings file: it will then reboot

 You can import settings files ONLY if the originating communicator has the same installer code.
 If folder B_PROG contains both the files export.txt and import.txt, the communicator will first export its current settings
(backup) and then import the new ones.

Exporting Voice Messages
This operation exports the communicator's voice messages to a USB key.
1.
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2.
3.

Create a new text file in B_AUDIO and call it export.txt.
Insert the key into the communicator's USB port.

The communicator will export its voice messages to B_AUDIO\SSSSSSSS\EXPORT\eaudnnn.bin, where:





SSSSSSSS is the communicator's serial number;
eaud identifies the file as containing voice messages;
nnn is an index from 001 to 999;
.bin is the extension for a binary file.

The communicator will search EXPORT for the voice messages file with the highest index and create a new one with that index
incremented by one; if EXPORT already contains a file with the index 999, it will not export the file: the ACT LED will flash slowly
and the event USB Audio Export Failed - System will be logged to the event buffer.

Importing Voice Messages
This procedure imports voice messages from a USB key.
1.
2.
3.
4.
5.
6.

Create the folder B_AUDIO on the USB key, if it is not already there.
Create a new text file in B_AUDIO and call it import.txt.
Create the folder SSSSSSSS in B_AUDIO, where SSSSSSSS is the serial number of the communicator to which you wish to
import the messages.
Create the folder IMPORT in the SSSSSSSS folder.
Copy the audio file to the IMPORT folder: the settings file may be created as described in the export procedure, or on the
Console.
Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will import the voice messages.

 If folder B_AUDIO contains both the files export.txt and import.txt, the communicator will first export its current audio
(backup) and then import the new messages.

Exporting the Event Buffer
This operation exports the communicator's event buffer to a CSV format text file (Comma Separated Value) on the USB key: the
CVS file can be viewed with Excel and Noteblock.
1.
2.
3.

Create the folder B_LOG on the USB key, if it is not already there.
Create a new text file in B_LOG and call it log.txt.
Insert the key into the communicator's USB port.

The communicator will export its event log to B_LOG\SSSSSSSS\EXPORT\elognnn.csv, where:





SSSSSSSS is the communicator's serial number;
elog identifies the file as an event buffer;
nnn is an index from 001 to 999;
.csv is the file extension.

The communicator will search SSSSSSSS for the log file with the highest index and create a new one with that index incremented
by one; if SSSSSSSS already contains a file with the index 999, it will not export the file: the ACT LED will flash slowly and the
event USB Log Export failed - System will be logged to the event buffer.
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Pass-Through
This function allows PowerSeries Neo v1.2 panels and above, and PowerSeries v4.1 panels and above to be remotely programmed via cellular or Ethernet channel using the communicator and the latest console version. You can download the latest console version from www.dsc.com, as illustrated in figure 10.

Figure 10 – Remote programming with the console: A) panel; 1) The operator launches a communications session on the
console by selecting the Cellular (IP remote) connection type — the console displays the information required for
the SMS; 2) The operator sends the SMS with his own phone, using the displayed information; 3) The SMS
specifying the console's public IP and port is sent to the communicator; 4) The communicator connects to the console
via cellular or Ethernet channel; 5) The console communicates with the panel (upload/download options) via the
communicator.

The communicator must be programmed accordingly before connecting it to the panel.

 Serial communications via the PC-LINK connector are interrupted when working with the USB key, so the panel may report
an error.

Programming the communicator
To program the communicator, see the section “PC PROGRAMMING” on page 42. Proceed as follows, using the console.
1.
2.

Enable Remote Access on the communicator (see Network Settings page).
If you want to use the cellular network, program a valid Remote Access APN on the communicator (see Network
Settings page).

 Make sure the PST jumper is in place: when the PST jumper is inserted, the USB port is NOT enabled for Communicator
programming by means the Console (USB Device mode), it is enabled for the USB keys only (USB Host mode).
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Connecting the communicator to the panel
To connect the panel to the communicator, use the PCLINK-PCLINK cable supplied with the communicator, connected to the PCLINK 15 connector on the communicator and the PC-LINK connector on the panel (CON4 on PowerSeries panels; CON5 on PowerSeries Neo panels), taking care to insert it in the right orientation (see figure 11).

B
B

A

B

A

PowerSeries Neo

NO

B

PowerSeries

Figure 11 – Connecting the communicator to the panel with the PCLINK-PCLINK cable: A) Communicator; B) white wire.

Panel procedure
Make the following checks on the panel.
1.
2.

Check section 382 o the panel: option 5 must be set to ON.
NO faults are permitted, the GREEN LED on the panel must be ON: this indicates that the panel is detecting the
communicator as connected and valid.
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PC procedure
Proceed as follows on the PC before remotely programming with the console.
1.
2.
3.

The PC must have a public IP address and a public port for the console's incoming connection.
The firewall and router must permit connection of the PC's public port to port 51004 on the console.
Make sure it is possible to access the router's public port from another PC to check that the console can be accessed by
the device.

Setup existing account
1.
2.
3.
4.

Launch the console on your PC.
Right click on the desired account and select Properties.
On the left of the Account Name window, select the control panel in the Panels/Modules branch.
In the Module menu, select the communicator connected to the control panel, and click Add.

 When you add a communicator to an account, you see the communicator's options with the control panel's options inside the
console (see the GS / IP option group).
5.
6.
7.

On the left of the Account Name window, select the added communicator under the control panel branch.
Enter the communicator’s Device ID, and set the EN50136 option as required: the communicator's Device ID is on its
PCB.
In the Connection Type menu, select Cellular (IP remote) if you want enable the pass-though via the cellular channel
of the communicator, or select IP if you want enable the pass-though via the Ethernet channel of the communicator, then
click Add.

 You can select IP if you have selected a dual-path communicator on step 4, the communicator is connected to a LAN or WAN
though the Ethernet interface, and you know the public IP address of the communicator.

 If you select Cellular (IP remote), the pass-through is performed via the Ethernet channel if the control panel is connected
to a dual-path communicator and the communicator is connected to a WAN via its Ethernet interface.
Cellular (IP remote) connection type

IP connection type

8. On the left of the Account Name window, select Cellular On the left of the Account Name window, select IP in the
(IP remote) under the communicator branch.
communicator branch.
9. Enter the communicator phone number in the Panel Phone
Number option and select the time that the communicator
waits for the connection SMS in the Connection Timeout
menu.

Enter the public IP address of the communicator in the IP
option. If you do not know the IP address of the
communicator, and the communicator is connected on the
same PC’s LAN, proceed to step 10.

10. Click Save.

Click AUTO Discovery and wait for the console to identify
the communicators connected to the LAN.

11.

Select the required communicator: the IP option is
automatically filled with the IP Address of the selected
communicator.

12.

Click Save.

You can now communicate remotely with the control panel via cellular or Ethernet, as indicated in “Downloading and uploading
options” on page 89.

Setup new account
1.
2.
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3.

In the Connection Type menu, select one of the GPRS or IP item, according to the communicator connected to the control
panel.

 For dual-path communicators there are GPRS and IP option: you can select the IP option if the communicator is connected to
a LAN or WAN though the Ethernet interface, and you know the public IP address of the communicator.
4.
5.

Enter the communicator’s Device ID, and set the EN50136 option as required: the communicator's Device ID is on its
PCB.
Set the other options as indicated on the control panel’s instructions.
GPRS connection type

IP connection type

6. Enter the communicator phone number in the Panel Phone
Number option and select the time that the communicator
waits for the connection SMS in the Connection Timeout
menu.

Enter the public IP address of the communicator in the IP
option. If you do not know the IP address of the
communicator, and the communicator is connected on the
same PC’s LAN, proceed to step 7.

7. Click Create.

Click the Advanced button: the Account Name windows
opens.

8.

On the left of the Account Name window, select IP in the
communicator branch.

9.

Click AUTO Discovery: the table in the IP Detected
section will show the communicators found on the LAN.

10.

Select the required communicator from the IP Detected
table: the IP Address of the selected communicator will be
copied in the IP filed.

11.

Align the option Port with the option Ethernet Local
Incoming Port in Network Settings > DLS, if you
changed the factory setting 3062.

12.

Click Create.

You can now communicate remotely with the control panel via cellular or Ethernet, as indicated in “Downloading and uploading
options” on page 89.

Downloading and uploading options
1.
2.
3.
4.

Open the account.
Select the required downloading or uploading operation: Global Upload, Global Download, Communicate Tags: the
connection window shows the communicator or the control panel, depending on the options to download and upload
Select the device’s options to upload and download in the Selected column, and choose the connection type for the control
panel and the communicator.
In the Connection Type menu, select the desired connection type: you can select Cellular (IP remote) and IP
depending on the connection you set (see “Setup existing account” on page 88 and “Setup new account” on page 88).

 You can disable the option Automatically Hangup when Finished to keep the connection live until you click the
button under the Disconnect When Complete

Disconnect Immediately

Cellular (IP remote) connection type
5. Click OK: the SMS Message Generator window
displays.

GS4015/GS4005/3G4005/TL405LE

menu.
IP connection type

Click OK: the console add the job to the queue.

firealarmresources.com

89

Cellular (IP remote) connection type

IP connection type

6. Type the public IP address of the router to which the PC is
connected in the option Public IP Address and the port to
access the console (DLS Port): ask the network
administrator or see the router’s instructions.
7. If this is the first time installed, press APN Settings and set
the APN Name, User Name, and Password for mobile
data services (ask the operator of the mobile data service).
sure to type the correct APN for WAP access,
 Make
otherwise some functions may be limited.
8. Prepare an SMS message as outlined in the SMS Message
Generator window or scan the QR code shown in the same
window, then click OK: the console waits for incoming
connection.
9. Send the SMS to the communicator number before the
Connection Timeout time expires.
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FCC Compliance Statement
CAUTION: Changes or modifications not expressly approved by Tyco
Safety Products Canada Ltd. could void your authority to use this equipment.
This equipment generates and uses radio frequency energy and if not
installed and used properly, in strict accordance with the manufacturer's
instructions, may cause interference to radio and television reception. It has
been type tested and found to comply with the limits for Class B device in
accordance with the specifications in Subpart “B” of Part 15 of FCC Rules,
which are designed to provide reasonable protection against such interference in any residential installation. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment
does cause interference to television or radio reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

 Re-orient the receiving antenna
 Relocate the alarm control with respect to the receiver
 Move the alarm control away from the receiver
 Connect the alarm control into a different outlet so that alarm control

and receiver are on different circuits.
If necessary, the user should consult the dealer or an experienced radio/
television technician for additional suggestions. The user may find the following booklet prepared by the FCC helpful: “How to Identify and Resolve
Radio/Television Interference Problems”. This booklet is available from
the U.S. Government Printing Office, Washington, D.C. 20402, Stock #
004-000-00345-4.
Wireless Notice
This equipment complies with FCC and IC radiation exposure limits set
forth for an uncontrolled environment. The antenna should be installed and
operated with minimum distance of 20 cm between the radiator and your
body. This transmitter must not be co-located or operating in conjunction
with any other antenna or transmitter.
Antenna gain must be below:
TL405LE-LAT
Band

B1 (2100)
B2 (1900)
B3 (1800)
B4 (1700)
B5 (850)
B7 (2600)
B8 (900)
B28 (700)

2G

HSPA+

LTE FDD

X
X

X
X
X

2.15
2.15
2.15

X
X

X
X
X

2.15
2.15
1.8
2.15
2.15

X
X

X

Ringer Equivalence Number (REN)
The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a telephone line may result
in the devices not ringing in response to an incoming call.
In most but not all areas, the sum of RENs should not exceed five (5.0). To
be certain of the number of devices that may be connected to a line, as
determined by the total RENs, contact the local Telephone Company. For
products approved after July 23, 2001, the REN for this product is part of
the product identifier that has the format. US: AAAEQ##TXXXX. The
digits represented by ## are the REN without a decimal point (e.g., 03 is a
REN of 0.3). For earlier products, the REN is separately shown on the
label.
Incidence of Harm
If this equipment TL405LE-LAT causes harm to the telephone network,
the telephone company will notify you in advance that temporary discontinuance of service may be required. But if advance notice is not practical,
the Telephone Company will notify the customer as soon as possible. Also,
you will be advised of your right to file a complaint with the FCC if you
believe it is necessary.
Changes in Telephone Company Equipment or Facilities
The Telephone Company may make changes in its facilities, equipment,
operations or procedures that could affect the operation of the equipment.
If this happens the Telephone Company will provide advance notice in
order for you to make necessary modifications to maintain uninterrupted
service.
Equipment Maintenance Facility
If trouble is experienced with this equipment for repair or warranty information, please contact the facility indicated below. If the equipment is
causing harm to the telephone network, the Telephone Company may
request that you disconnect the equipment until the problem is solved. This
equipment is of a type that is not intended to be repaired by the end user.
Tyco Atlanta Distribution Center, 2600 West Pointe Dr., Lithia Springs,
GA 30122
Additional Information

Max.
Antenna
Gain (dBi)

X
X

compatible modular jack that is also compliant. See installation instructions for details.

IMPORTANT INFORMATION
This equipment complies with Part 68 of the FCC Rules. On the side of this
equipment is a label that contains, among other information, the FCC registration number and ringer equivalence number (REN) for this equipment. If
requested, this number must be provided to the Telephone Company.

Connection to party line service is subject to state tariffs. Contact the state
public utility commission, public service commission or corporation commission for information.
Alarm dialling equipment must be able to seize the telephone line and
place a call in an emergency situation. It must be able to do this even if
other equipment (telephone, answering system, computer modem, etc.)
already has the telephone line in use. To do so, alarm dialling equipment
must be connected to a properly installed RJ-31X jack that is electrically in
series with and ahead of all other equipment attached to the same telephone
line.
Proper installation is depicted in the figure below. If you have any questions concerning these instructions, you should consult your telephone
company or a qualified installer about installing the RJ-31X jack and alarm
dialling equipment for you.

TL405LE-LAT Product Identifier US:F53MO00ATL405LE
REN:0.0A
USOC Jack:RJ-31X
Telephone Connection Requirements
A plug and jack used to connect this equipment to the premises wiring and
telephone network must comply with the applicable FCC Part 68 rules and
requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a
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#

Control String

Calling Number

Deactivation*

1
2
3
4
5
6
*) Write “Text Message” for bistable outputs or the Activation Time for monostable outputs.
Bistable Output Activation: #User Code*Control String=ON*
Monostable Output Activation: #User Code*Control String=ON*TonU*
Ton = Activation Time; U = S for seconds, M for minutes, H for hours
Output Deactivation: #User Code*Control String=OFF*
User Code Change: #CUC*User Code*New User Code*
Installer Enable: #ENI*User Code*
Installer Disable: #DSI*User Code*
Remote Programming Enable: #ERA*User Code*ON*
Remote Programming Disable: #ERA*User Code*OFF*
SIM Balance Check: #CCC*User Code*
SIM Expiration Check: #EDC*User Code*
SIM Expiration Change: #EDU*User Code*DD/MM/YYYY*
Serial Number Display: #RID*User Code*

© 2020 Johnson Controls. All rights reserved. JOHNSON CONTROLS, TYCO and DSC are trademarks of Johnson Controls.
Digital Security Controls
www.dsc.com

29010881R002 240820 FM14

firealarmresources.com

